Installation, Operation, and
Maintenance manual
for the EMT 1
embroidery peripheral

•

•

Part Number 12095, Revision A

Single-head, single-needle tubular
embroidery peripheral

1575 West 124th Avenue
Denver, Colorado 80234
United States of America
E-mail: publications@melco.com

© Copyright 1998 by Melco Embroidery Systems
ALL RIGHTS RESERVED No part of this publication may be reproduced, stored in a retrieval system,
or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or
otherwise) without prior written approval of Melco Embroidery Systems. Melco reserves the right
to revise this publication and to make changes in it at any time without obligation of Melco to
notify any person or organization of such revisions or changes.
All precautions have been taken to avoid errors or misrepresentations of facts, equipment, or
products. However, Melco does not assume any liability to any party for loss or damage caused by
errors or omissions.
All trademarks and trade names contained within this publication are the property of their respective owners.
Printed in the United States of America
Revision A, November 1998

Table of Contents

Table of Contents
General
EMT 1 Specifications
Explanation of Symbols

iv
vi

1. Installation
Unpacking
Moving the Peripheral
Cart Assembly
Connecting cables
First Powerup
Language Selection

1-1
1-2
1-3
1-5
1-7
1-8

2. Operation
Hazards of Operation
Threading
Tensions
Keypad
The Menus
Main Operator Menu
Disk Directory Menu
Design Menu
Run Design Menu
Function Menu
Options Menu
Frame Menu
Reset Menu
Service/Maintenance Menu
Head Timing Menu
4 Hr Lubrication Menu
8 Hr Lubrication Menu
40 Hr Lubrication Menu
80 Hr Lubrication Menu
480 Hr Lubrication Menu
2100 Hr Lubrication Menu
Configuration Menu
Move Function Menu
Define Custom Hoop

2-2
2-4
2-7
2-8
2-10
2-10
2-10
2-10
2-10
2-11
2-12
2-14
2-14
2-14
2-14
2-15
2-15
2-15
2-15
2-15
2-15
2-16
2-17
2-17

i

Table of Contents

Test Mode
Diagnostics Menu
Disk Drive
Loading a Design
Hooping
Quick Start
Set Home
Select Hoop
Select Orientation
Center Hoop
Place Hoop on Machine
Select a Design
Trace the Design
Start Embroidering
Embroidery Speed
Idle Display

2-18
2-18
2-19
2-20
2-21
2-22
2-22
2-22
2-22
2-22
2-23
2-25
2-25
2-25
2-25
2-26

3. Accessories
Standard Cap Frame
Wide-angle cap frame
Sash Frame
Spider Hoops
Lamps
Bobbin Winder

3-1
3-6
3-15
3-16
3-18
3-18

4. Operator Maintenance
Installing a Needle
Cleaning
Lubrication
Time to oil hook
8 Hr Maintenance
40 Hr Lubrication Menu
80 Hr Maintenance
480 Hr Maintenance
2100 Hr Maintenance
Replacement Parts

4-1
4-2
4-2
4-3
4-4
4-5
4-6
4-9
4-10
4-12

ii

Table of Contents

5. Troubleshooting Guide
Thread Breakage
Skipped Stitches
Needle Breaks
Loose Stitches
Other Issues
Wide-Angle Cap Frame

5-1
5-2
5-2
5-3
5-3
5-4

6. Error Messages
7. Glossary of Embroidery Terms
Index
Quick Reference Guides

iii

Single-Head Embroidery Peripheral
EMT 1 Specifications

Maximum embroidery speed

Recommended power conditioning equipment

1000 stitches per minute

LC 1800 Line stabilizer (available from
Accessory Resource Corporation)
Number of heads
Embroidering field size

1

28 x 50cm (11 x 19.7") with the Sash Frame
26 x 41cm (10.25 x 16.15") with a tubular frame

Needles per head
1

Options
Dimensions

Cap frame option
Wide-angle cap frame option
Sash frame option
Bobbin winder option
Cart option

114cm W x 79cm H x 89cm D
45" W x 31" H x 35" D
Weight
91kg
200 lbs

Compatibility
EDS III and Wilcom

Shipping weight
Intended use

130kg
285 lbs

The EMT 1 is designed to embroider on textile
products which are placed easily in a Melco
embroidery hoop. The machine should not be
used on thick leather, wood, plastic, or other
dense material.

Power consumption
100 W

The EMT 1 is designed to embroider using
tubular and flat hoops, cap frames, and the
sash frame.

Noise level and test conditions
Equivalent continuous A weighted sound pressure level at 1.3 meter from the floor is 78.5db.
The peak C weighted instantaneous sound
pressure level is 77.5db.
The noise level was measured sewing a test
design at 800 spm.
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Explanation of Symbols
Caution!

Indicates a machine component will move. Keep clear!

Shock hazard. No user replaceable parts behind this label. Do not open!

Pinch point, Keep clear!

Pinch point, Keep clear!

Pinch point, Keep clear!

Needle pinch point, Keep clear!

v
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Unpacking
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1. Installation
Read the entire manual before operating the machine. Save all packing material; if you ever need
to move the peripheral, use the original packing material.

Unpacking
Remove the packing straps holding the box together using a knife. Lift off the top of the box, and
then remove the sides of the carton. Remove the plastic bag enclosing the equipment. When the
plastic is off, refer to Figure 1-1 for further instructions.

Remove
these boxes (one
contains the
operator kit)

Remove these
foam braces

Remove the
tabletop

Remove these
foam braces

Figure 1-1
Prepare the designated area for the peripheral. If
you have purchased the cart option, you must
clear a temporary location for the machine (until
you have assembled the cart and removed the
feet from the machine). Two people are required
to lift the EMT 1. Refer to Figure 1-2 to locate
the hand-holds. Lift with one person holding the
handles at each end.

Figure 1-2
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Moving

Moving the Peripheral
Make sure you leave enough room around your
peripheral to have easy access to all sides. Use
two people to lift the machine; use the handholds shown in Figure 1-3.
If the machine is on a cart, disengage the brakes
on the indicated wheels before attempting to
move the machine. Engage the brakes when the
machine is in the desired location. Observe the
precautions below. You cannot remove the
machine from the cart without first removing the
4 bolts securing the machine to the cart.

Figure 1-3

Push carefully in the directions
shown or the cart may tip.

Brakes

Figure 1-4
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Cart Assembly (EMT 10T Only)

Grasp here
3

If you purchased the optional cart with the EMT
10T, you must assemble the cart and mount the
peripheral on the cart. The following section
describes how to assemble the cart and attach the
EMT 10T. To dismantle, reverse these steps.

1
Straight Flange

The cart has 5 pieces. They attach as shown in
Figure 1-11. Use the enclosed hardware to build the
cart. Pieces 1, 4, and 5 are identical to each other.
Pieces 2 and 3 are also identical to each other.

x
Stand here
2

Referring to Figure 1-9 and 1-10, lay piece 1 on top
of the existing cardboard packaging with the
straight flange pointing down. Attach piece 2 with
Bent flange
wheels on the same end as the straight flange on
piece 1 (see Figure 1-10). The wheels with the
brakes on them should be on the ground as shown
in Figure 1-9. Insert the necessary screws (M5
phillips head screw with a flat washer between the
screw and the cart piece) securing them tightly.
Attach piece 3 the same way. While standing in
area indicated in Figure 1-9, grasp and carefully lift
cart off of cardboard and place all four wheels onto
floor.

Figure 1-9
1

Straight flange

Figure 1-10

Referring to Figure 1-11, place pieces
4 and 5 resting on top of the cross
bars of pieces 2 and 3 and piece 4
resting on the straight flange of piece
1. The straight flange of pieces 4 and
5 will be placed together in the middle of the cart assembly. Insert the
necessary screws (M5 phillips head
screw with a flat washer between the
screw and the cart piece) securing
them tightly.

3
1

4
5

2

Figure 1-11
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The Cart

Mounting the EMT 10T on the cart
1. Remove the main tabletop.
2. Remove the side covers; there are 5 screws holding each
side cover in place (see Figure 1-12). Use the #2 Phillips
head driver included in the operator kit to remove the
screws.

Caution! The side panels are heavy; if
dropped, damage may occur.

Screws

Figure 1-12

3. Lift the EMT 10T (2 people are required) and carefully place the machine on the “pillars” of
the cart. The 4 holes where the feet attach should be aligned with the 4 holes on the cart’s
pillars. If the holes do not match up then slightly loosen all of the cart screws for flexibility.
4. Secure the machine to the cart using the M6 socket-head cap screws, a flat washer, and a
lock washer (provided with the cart). Refer to Figure 1-13.
Install the flat washer, then the lock washer, then the bolt.
5. Make sure the cart is standing straight, tighten all screws.
6. Replace the side covers.
7. Replace the tabletop (if desired).

Installing the feet

Figure 1-13

If you have purchased the Foot option with your EMT 10T, refer to these steps to install the feet.
1. Remove the main tabletop.
2. Remove the side covers; there are 5 screws holding each side cover in place (see Figure 1-12).
Use the #2 Phillips head driver included in the operator kit to remove the screws.

Caution!

The side panels are heavy; if dropped, damage may occur.

3. Working on one side at a time, raise the machine and support it securely. The machine should
be lifted approximately 4" (10cm).
Turn at
4. Install the 4 “feet” on the peripheral (see Figure 1-14). Turn the flats
lock nut
the indicated flat section of the stem with an adjustable
to adjust
wrench to install or remove the foot on to the peripheral.
5. Place the machine on the surface where you intend to use it,
and level the machine. Adjust the appropriate feet by turning
the stem up or down and sequre with the lock nut against
the peripheral.

Operation Manual for the EMT 1
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Connecting cables
Power requirements

ON
(green)

Melco suggests using a dedicated line with a line conditioner (available from Accessory Resource Corporation). Do not
use any power cable that appears to be damaged. If your
power cable appears to be damaged, order a new power
cable from your Melco representative.
1. Figure 1-10 shows the power in the ON position. Turn
the power OFF before connecting ANY cables.

OFF
(red)

Figure 1-10

2. If your peripheral is equipped with a voltage selector switch, set it to the correct position for
your area.
3. Plug the power cable to the rear of the unit as shown in Figure 1-11.
4. Plug the other end of the cable into the line conditioner.
5. Connect the line conditioner to the power source.
Rear of peripheral

Network
cable plug

Voltage
selector switch (if
applicable)

Power cable plug

Figure 1-11
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Networks

Attaching the peripheral to a network
The EMT product line is compatible with Ethernet network technology. With Ethernet, peripherals
connect to a wiring hub, and the hub connects to an EDS III or Wilcom computer. The hub is a
small electronic device that contains a number of cable jacks and diagnostic lights. The peripherals, EDS III computers, and Wilcom computers can plug into any port on the hub. You can connect
as many peripherals or computers as your hub can hold. If you have more peripherals or computers than your hub has ports, you can daisy-chain 2 (or more) hubs together.
Refer to Figure 1-12 for a sample Ethernet network.

Ethernet hub
EMT 10/12
EDS III
Computer*
EDS III
Laptop*

EMT Products

Each cable may be up to 100 meters (327 feet) long. Hubs may be daisy-chained
for more capacity or distance.

Figure 1-12
Note: You may have as many licensed EDS III systems operating on an Ethernet network as you
choose. Each computer running EDS III on the network must have a licensed EDS System
(including the dongle) installed to operate properly.

Operation Manual for the EMT 1
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First powerup
Diagnostic tests
Every time the peripheral powers up, it goes through a series of diagnostic tests. A series of messages will flash on the display. These diagnostic tests verify the proper function of the peripheral’s
CPU and the network card (if present). After the tests, the BIOS revision level will be displayed; if
you are running an Ethernet network and no EDS or Wilcom computer is on-line, the display may
read: Insert Boot Disk.
If any of the diagnostics fail, the CPU will halt and the machine will not boot. This indicates a
problem with the CPU. Contact your Melco Service Representative.

Configuring the peripheral
The first time the machine is turned on, it must be configured with a peripheral program and unit
name. This information is stored in memory and retrieved during each power up. If the peripheral is not configured correctly, it will not operate properly and may be damaged.
The unit name is a unique address for each machine. The machine uses the unique EtherNet
address as a default. You may change this to any 16 (or less) character name. Use a unique name
for each machine if you have more than one machine on your network.
To configure the peripheral:
1. Turn ON the power.
2. Ignore any message flashing on the LCD.
3. Press and hold
on the power.

▲

▼

at the same time within 12 seconds after you turn

4. Continue to hold the keys until the machine beeps, then release.
▲

or

▼

to scroll to the correct

8. Press

▲

▼
▲
7. Press
or
to change the characters in the name and press
to move to the next or previous character.

or

▼

and the peripheral program is set.
▲

6. Press

▲

5. The LCD should display the model name; press
model name for your machine.

to set the unit name.

The machine should now be properly configured.
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Language Selection

Language selection
All Melco products use English as the default language. If you wish to change the display to a different language, follow these steps to select the machine language:
Note: The machine must be configured, and the RSA files must already be downloaded before
you can change the display language.

to scroll through the available language selections.

Operation Manual for the EMT 1

▲
▼

3. When the desired language is selected, press

▼

▲

▼

or

to enter Language Selection

▲

▼

▲

▲

2. Press

▼

▲

▲

1. Press

to return to the Main Menu.
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2. Operation
This chapter outlines machine operation; in addition, operators must attend a Melco approved
training course prior to operating the machine.
Saddle bag

X-carriage
Keypad
Power switch

Needle case

Table

Figure 2-1
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Operation

Hazards of operation
Caution! Below are risk areas or danger points encountered during operation. Always wear eye protection while operating the
machine to prevent injury in the event of a needle break. Do not
wear loose or baggy clothing when operating the machine.

Take-up Lever Oscillation
Do not touch the take-up lever during operation

Cap Frame Pinch Points
Do not touch the cap frame, driver, or driver bar during operation.

Operation Manual for the EMT 1
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Exposed Needles During Operation
Do not place body parts or other foreign objects under the needle
during operation.

Pinch Points
Do not rest hands or other objects on the tabletop during operation.
Do not reach behind the x-carriage during operation with or without
the tabletop in place.

Rotary Hook Rotation
Do not attempt to change bobbin thread during operation. Do not
place hands or other objects in the rotary hook area during operation.
Do not operate the machine without the hook guards in place.

12095 Rev. A
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Threading

Threading
The plastic thread saddle mounts over the sewing head and holds up to six cones of thread. Figure
2-3 shows how the thread positions are numbered in the saddle. The thread tree is the metal
structure that mounts above the sewing head. It guides the threads toward the front of the
machine.
Pigtail
Thread tree

Pretensioner

Thread
saddle

Take-up
lever

Main
tensioner

Figure 2-2
The thread tree has guide holes along the front for all the thread
positions. There are also guide holes on each side for positions 2
through 5. Positions number 1 and 6 are close enough to the
front not to need side holes.

4

3

5

2

Follow these steps to thread the EMT 1:

6

1

1. Place a cone of thread in the thread saddle.
2. Route the thread toward the front of the peripheral. For positions 2 through 5, route the thread through the side holes,
outside to inside.

Operation Manual for the EMT 1

Front of machine
Figure 2-3
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Threading

3. Along the front of the
thread tree are six pairs of
holes. Figure 2-4 shows
which pair of holes corresponds to each thread
cone position. The thread
should be routed through
the pair of holes as shown
in Figure 2-4.

2-5

4
5
6
6

3

5
4
3

4. Route the thread through
the front of the thread
tree for each thread position. Pull 3-5" of thread
through the thread tree.
5. Select the thread you will
use for your design, then
route it through the pigtail on top of the head.

1
1

2

Figure 2-4

6. Route the thread down
around the center of the metal disk of the pretensioner.
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Threading

7. Route the thread
through the second
pigtail and down to
the main tensioner
(see Figure 2-5). Wrap
the thread around the
main tensioner disk
clockwise 11/2 times.

Pigtail
Take-up
lever

Pretensioner

8. Route the thread
through the take-up
spring attached to the
main tensioner. When
you pull on the
thread, the take-up
spring should break
contact with the
thread break sensor
post.
9. Route the thread down
through the upper
thread guide.
10. Bring the thread up,
and through the takeup lever eye, from
right to left.
11. Drop the thread
through the thread
guide, then through
the lower thread
guide.

Pigtail

Main
tensioner

Upper thread
guide

Retaining
screw

Lower thread
guide

Presser
foot

Figure 2-5

12. Run the thread through the eye of the needle, from front to back.
12. Pass the thread through the center of the presser foot.
13. Pull on the thread until you feel tensioner pressure.
14. Set the tension to equal 80-120 grams required to pull the thread at the needle end.
15. Wrap the thread around the retaining screw and trim the end to about an inch in length.

Operation Manual for the EMT 1
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Tensions
Embroidery tensions are controlled on both the upper and bobbin thread. To set the tension, sew
a column (satin stitch), or embroider a capital letter “I”. You should have bobbin thread across
approximately the middle 1/3 of the total column width on the back. If you do not, refer to the following table to adjust tensions.
Note: Do not attempt to judge tension by looking at the back of a fill stitch.

Problem

Solution

Bobbin thread showing on top of garment

Top tension too tight and/or bobbin tension
too loose
Bobbin tension too loose and/or top tension
too tight
Bobbin tension too tight and/or top tension
too loose
Top and/or bobbin tension too tight
Top tension too loose

More than 1/3 of column showing bobbin
thread on back of garment
Less than 1/3 of column showing bobbin
thread on back of garment
Design puckering
Top thread in design loose (looping)
Top tensions
Pretensioners

The purpose of the pretensioner is to hold the thread
taut for the main tensioner. The thread should pull
easily through the pretensioners.
Main tensioners
Sets the upper tension. Tighten tension by turning the
knob clockwise. Loosen by turning counterclockwise.

12095 Rev. A

Rotate to adjust tension

Figure 2-6
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Keypad

Bottom tensions
Leave 2-3 inches (5-7.5cm) of thread hanging free. Insert the bobbin and case with the pigtail facing
up. Set the tension at approximately 7-14 ounces (20-40 grams) required to pull thread from the bobbin.
Bobbin case
Side

Front

Bobbin

Make sure you
insert the
thread through
the pigtail.
Pigtail

Set screw

Note the thread
direction

Figure 2-7

Keypad
Emergency Stop (Bright yellow with a red center); stops all sewing motion immediately.
To reset, pull or twist slightly and the button snaps back into place.
Starts embroidering (sometimes referred to as the start button). It is also used to execute selected functions in the Function menu. Hold down to stitch at inching speed.
Stops machine motion. Press twice to enable manual jogs of the rack when you are in
the middle of a design.
Used to “frame forward” or “frame backward” in idle or in the FRAME menu. Holding
the key will cause the machine to frame one stitch at a time; release the key to stop
framing. Holding the key for 10 seconds starts the auto-frame function; once the autoframe function has started, you must press
to stop framing. The default setting is to frame back one stitch at a time.
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Moves from one menu to the next. After the last menu displays, it wraps back to the
first menu.
Never used alone. It is held down while pressing an additional key, allowing the other
key to take on an alternate function.
▲

Makes a selection. It is similar to clicking the OK button in Windows or pressing the
[ENTER] key on your keyboard.

Moves the needle position back in the embroidery field. It also scrolls up a menu list. It
is also used to change sub-menu values.

▼

Moves the needle position forward in the embroidery field. It also scrolls down a menu
list. It is also used to change sub-menu values.
▼

▼
▲

▲

Moves the needle position to the left in the embroidery field (hoop moves right). It is
also used to select values for sub-menu options.

Does not function on the EMT 1.

▼

Moves the needle position to the right in the embroidery field (hoop moves left). It is
also used to select values for sub-menu options.

▲

Toggles the hoop carriage speed fast or slow when manually jogging the rack.

A rack enable switch; hold down and use with the arrow keys to manually jog the
rack.

▲

▲
▼

Hotkeys

When pressed simultaneously, displays the previous menu.

▲

When pressed simultaneously, exits any sub-menu and displays one of the idle
menus, even when the machine is embroidering.
Toggles between the Main menu and the Service/maintenance menu.

▲

Increases sewing speed by 50 spm (while machine is in operation).

▼

Decreases sewing speed by 50 spm (while machine is in operation). In idle
state, deletes a design in the Design menu.
▼

▲

▲
▼

12095 Rev. A

Toggles to Language Selection from current menu.
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The Menus

The Menus

▲

The menu structure is divided into two top-level menus, the Main Operator menu and the
Service/Maintenance menu. To toggle between these top-level menus press
. To
enter any submenu under one of the two top-level menus, press
. Following is a list of
all the menus available in each and what commands are available.

Main Operator Menu
The Main operator menu is the menu the machine defaults to when powered up. All functions
required for embroidering are found in this menu. Several submenus are in the Main operator menu.
Press
to toggle between the Main menu and the Service/Maintenance menu.
Disk Directory Menu
▲

▼
Lists designs on the floppy disk in the EMT Disk Drive. Use ▲ or
to scroll through
design names. Press
to load the design into machine memory. This menu will not appear if
the NO FORMAT option is selected (refer to the Disk Design Format section for more information).

Design Menu
▲

▼
Lists designs stored in machine memory. Use ▲
or
to scroll through the design
names. Press
to select a design to be sewn. Up to 16 designs (or up to 500K) may be
queued.

Run Design Menu
▲

Confirms the selected design is ready to be embroidered. Press
into the queue (up to 16 designs may be queued—or up to 500K). Press
will emit several beeps) to start embroidering the design.

Operation Manual for the EMT 1

to load the design
(the machine
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Function Menu
All the commands in this menu result in machine motion and multiple beeps. The commands are described below. Press
or
to view selections.
▲
▼
Go to hoop center?
Forces an X/Y move to the center of the selected hoop. Only allowed if you are not in the middle
of a queued design. Press
to perform function.
Trace design outline?
Traces the outline of the queued design. Pressing
once during the trace will stop the trace
temporarily. Press
to resume the trace, or press
again to abort. Refer to the
Trace part of the Quick Start section for more information.
Set home?
Causes the X and Y axis motors to move to home, then return to their starting positions. This
position is defined as home. Press
to perform function. Unless an error condition
occurs, this function is performed automatically every time the machine is powered up.
Power Fail rescue?
Power Fail rescue allows you to resume embroidering a design after the machine has a power loss.
A power loss might occur if an error requires turning the power switch OFF and then back ON for
recovery or if a power failure occurs. Follow these steps to regain your position in the design and
continue embroidering.
1. If a large garment is installed, remove it from the head while the power is OFF.
2. Turn the power ON. Wait for the machine to download and power up.

5. Press
6. Press
7. Press

▲

▲

4. Press

▲

3. Scroll through the menus until the display reads FUNCTION MENU.

▼

. The display reads GO TO HOOP CENTER?.
until the display reads GO TO HEADUP.
(if you are using Wilcom, you may need to resend the design).
until the display reads POWER FAIL RESCUE.

9. Press

▲

8. Press
. The beam and carriage assemblies will move to find home, then
return to the next to last stitch embroidered before the power failure. This may take
a minute or so if it is a large design.
to return to the top level menu.

10. Reinstall the large garment that you removed in step 1 (if applicable).
11. Press

12095 Rev. A
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Return to origin?
Returns to the start position of a design that has been partially embroidered. Press
form function.

to per-

Return to last stitching position?
Returns to the last stitched position before continuing if manual jog X/Y was used to view the
design. Press
to perform function. You may use this function if you have manually
moved the x or y axis in the middle of a design. This function will return you to the last position a
stitch was sewn.

Go to headup?
Forces a move to the headup position, ready to sew. Press

▼

▲

▼

▲

Go to stitch?
or
to change a character
Allows you to move to a certain stitch number Press
▲
▼
within a design. Press
to perform function. Press
or
to clear
00000
ENTER STITCH NUMBER
the count. For example, you may use this function to move to a certain position in a design
Press
or
to change the cursor
that may not have sewn well.
position
to perform function.

▼

Used to set all machine options. Press ▲
or
to view the selections. Use
▼
or
to select submenu options. All options are stored in machine memory until
changed manually or until a hard reset is performed.

▲

Options Menu

Operation Manual for the EMT 1
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Select hoop:
Lists all defined hoops. The hoops will appear in the units you select during configuration (i.e.,
English or Metric). The list of defined hoops follows:
•

11.8" X 14.2" (30 X 36cm) Tube

•

8.3" (21cm) Tube

•

7.1" (18cm) Tube

•

5.9" (15cm) Tube

•

4.7" (12cm) Tube

•

11.8" X 17.3" (30 X 44cm) Tube

•

8.3" (21cm) Round

•

7.1" (18cm) Spider

•

5.9" (15cm) Spider

•

4.7" (12cm) Spider

•

3.5" (9cm) Spider

•

2.8" (7cm) Spider

•

Sock hoop

•

Sash Frame

•

2.8" X 5.6" (7 X 14.2cm) Large cap frame

•

2.5" X 5.6" (6.3 X 14.2cm) Small cap frame

•

2.8" X 14.3" (7 X 36.2cm) Wide-angle cap frame

Orientation option:
Select from eight different design orientations
represented by the letter F (illustrated at right).
Used to turn a design within a hoop (e.g., for
caps, you would change the orientation).
Turbo mode:
When disabled, the machine uses a reduced speed-to-stitch table, resulting in higher embroidery
quality, but slower embroidery speed. Enabled is the default. The maximum embroidery speed is
fastest when Turbo mode is enabled.
Center design:
Allows the design to be centered with respect to the start point. Enabled is the default.
Disk design format:
Selects the format of a floppy disk when loading designs from a disk. Options are DOS, TAJIMA,
BARUDAN FMC, BARUDAN FDR, ZSK, and NO FORMAT. You must choose the format in order to
load a design. The NO FORMAT option will remove the Directory menu from the menu tree. This
saves keystrokes if you never load designs from the disk drive. Select a format other than NO
FORMAT to make the Directory menu re-appear.
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or

.

▼

Selects the frame forward or frame backward function. Change by pressing

▲

Frame Menu

Clear design
Clears the current design from the queue (does not delete the design from memory). Press
to perform function.

▲

Reset Menu

▲

Hard reset
Resets all operator selectable options to the default values, clears the current design from the
queue. Press
to perform function.

Service/Maintenance Menu
Contains all service and maintenance functions. Eleven submenus are in the Service/maintenance menu.
Press
to toggle between the Service/Maintenance menu and the Main menu.
Head Timing Menu
Use the keystroke guide below to move to each position. Refer to the Hook timing section
of the Technical manual for more information. The Z position (in degrees) will be displayed
after each function.
▲
Go to headup
Forces the z axis to make one plus rotation and stop with needle in up position.
▲

One revolution
Forces z axis to move to headup position with needle in down position.

▼

▼
Needle depth
Must be done after One revolution command to insure the z axis is at its proper position.

Hook timing
Must be done after Needle depth command to insure the z axis is in its proper position.
▲

Top dead center ▲
Must be done after Needle depth command to insure the z axis is in its proper position. Used to
set upper dead stop position.
▲
1 degree forward
Forces z axis to move forward one degree.
▼

10 degrees forward
Forces z axis to move forward ten degrees.
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▼
1 degree back
Forces z axis to move back one degrees.
▲

10 degrees back
Forces z axis to move backwards ten degrees.
▼

▲
Z position
Releases the z axis to allow manual rotation with current z position display in degrees. Press
twice to exit Z position and lock Z axis.

4 Hr Lubrication Menu
Go to this menu when the message time to oil hook appears. This menu forces the machine to
move the hook to its proper position for oiling. Refer to the Lubrication section of Chapter 4 for
the proper place to apply lubricant.
8 Hr Lubrication Menu
Go to this menu when the message 8hr maintenance due appears. This menu forces the
machine to move to the proper positions for oiling. Refer to the Lubrication section of Chapter 4
for the proper place to apply lubricant.
40 Hr Lubrication Menu
Go to this menu when the message 40hr maintenance due appears. This menu forces the
machine to move to the proper position for oiling. Refer to the Lubrication section of Chapter 4
for the proper place to apply lubricant.
80 Hr Lubrication Menu
Go to this menu when the message 80hr maintenance due appears. This menu forces the
machine to move to the proper positions for oiling. Refer to the Lubrication section of Chapter 4
for the proper place to apply lubricant.
480 Hr Lubrication Menu
Go to this menu when the message 480hr maintenance due appears. This menu forces the
machine to move to the proper positions for oiling. Refer to the Lubrication section of Chapter 4
for the proper place to apply lubricant.
2100 Hr Lubrication Menu
Go to this menu when the message 2100hr maintenance due appears. This menu forces the
machine to move to the proper positions for oiling. Refer to the Lubrication section of Chapter 4
for the proper place to apply lubricant.
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Configuration Menu
This menu allows you to configure certain options. Normally these options are only configured
once, but you may set them as often as you wish. If a hard reset is performed, all these values will
return to their default values. The options follow:

▼

▲

Accumulate needle ups:
Accumulates consecutive needle ups and converts them into one large motion. Enabled is the
default. Press
or
to change.

▼

▲

Return to design origin at EOD (end of design):
Forces an X/Y motion back to the position at the start of the design if the end point is not the
same. Enabled is the default. Press
or
to change.

▼

▲

Start rack motion offset:
Allows a delayed start time of the X/Y rack motion in 5 degree increments depending on different
types of material used. Range is 0-20. 0 is normal movement, and the default. This delayed start
time may produce better embroidery results on delicate fabrics by allowing the needle to come
out of the fabric completely before rack movement occurs. Does not affect sewing speed, instead
the rack moves more quickly. Press
or
to change.

▼

▲

Unit of measure:
Allows selection of all operator prompts to be in IN (English) or CM (Metric). English is the default.
Press
or
to change.

▼

▲

Hoop limits:
Turns ON or OFF hoop limits. Default is ON. If you turn the hoop limits OFF, the machine will NOT
beep when it encounters a rack limit during a trace. You are at risk to hit the hoop when Hoop
Limits are turned OFF. Press
or
to change.
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▼

▲

Design filter:
Filters a design when it is queued. Filtering
removes all stitches equal to or less than the
selected short stitch length. Jump stitches and
needle ups are changed to normal stitches if
their sum is less than 12.7mm. If their sum is
longer than 12.7mm, they will be divided into
equal jump stitches less than 12.7mm. Refer to
the example illustration to the right. 3 jump stitches (20 points each) are converted into 1 normal
movement. Enabled is the default. Press
or
to change.
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▼

▲

Design filter stitch length:
Determines what short stitch length to use for filtering up to 0.9mm. The allowable range is 0-9
points. It accumulates stitches that are shorter than this value and adds them to the next stitch.
The default is 4 points. Press
or
to change.
Language selection:
Allows for different languages. Several languages are available.
Max Jump Stitch Speed
Selects the maximum speed that jump stitches can be sewn. The range is 400-900 spm; default is
700 spm.
▲
▼
Press
or
to change a character
MOVE X/Y

to change the cursor

▼

▲

▲

Move function
X 00.00 in Y 00.00 in
Press
or
Forces an X/Y move to a selected distance
position
from the present position. Press
or
to toggle between the X and Y axis. Press
to perform the move. This is useful to select a position in a hoop that is
not the hoop center.

X:+00.00IN Y:+00.00IN
▼

Move Function Menu

The illustration to the right shows where the X and Y coordinates
are positive and negative.

Define custom hoop

▲

Defines custom hoop sizes based on type of hoop, X/Y dimensions, and hoop center. Press
to start the process. You will be prompted to enter a hoop name (available names are Custom
Hoop 1-8). Use ▲
or
to change the hoop name. Press
to go on.
▼

▲

Note: Before you attempt to define a new custom hoop, center the 11.8" X 17.3" (30 X
44cm) Tube hoop.

▲

or

▲
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to change a character

Y:00.00IN X:00.00IN

Press
or
change the cursor position
▲

You will be prompted to choose the X and Y
dimensions (or diameter). Press
to go on.

Y/X LENGTH

▼

▼

Press

▲

You will be prompted to choose the type of
hoop (available choices are rectangle, cap,
▲
▼
oval, and circle). Press
or
to select the hoop type. Press
to
continue.

to
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▲

Next you must define your custom hoop’s center. To do this, measure from the center of the needle plate to the center of the hoop in the Y direction. Enter this value to define the new hoop’s
center. Press
to go on.

▲

▲
You will be prompted to save the hoop; press
for Yes or
for No. Then press
▼
to save the hoop. Your custom hoop will appear in the hoop list in the Options Menu. You
can overwrite a custom hoop, but once you have saved a custom hoop, it will remain in memory
until you reconfigure the peripheral.

Test Mode
Places the machine in test mode, where thread breaks are ignored and the queued design continues to run until
is pressed. Must be disabled to return to normal embroidery. This is primarily a service function.

Diagnostics Menu
The following service diagnostic test are available to run or view:
RSA rev level
Displays the current revision level of the RSA files and the selected machine type.
BIOS rev level
Displays the current revision level of the ROM BIOS.
Motion Controller rev level
Displays the current revision level of the DSP chip set.
FPGA rev level
Displays the FPGA (Field Programmable Gate Array) rev level.
+5 Volt Current
Displays the +5 volt (in amps) of the power supply.
Sew timers
Displays the total accumulated CPU time, and total sew time. The CPU time accumulates when
the machine is turned on, and the sew time accumulates when the machine is embroidering.
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Disk Drive
The EMT Disk Drive is a read only disk system allowing the user to embroider EXPANDED designs
in the following formats: DOS 1.44MB, DOS 720K,Tajima, Barudan FMC, Barudan FDR, and ZSK.
The drive does NOT support condensed format designs. The disk drive replaces the need for the
EDS System Controller, thus converting a peripheral into a single embroidery device.

Installing .RSA Files
If the peripheral is part of an EDS or Wilcom System and the network will boot the peripheral, you
must install the .RSA files into the EDS III computer. To install the .RSA files, start Microsoft®
Windows®, put the RSA disk into the disk drive, and follow these steps:
→Run from the Windows 95 taskbar (or File→
→Run from the Windows 3.x
1. Click on Start→
Program Manager) to display the Run dialog box.
2. Type a:\setup.exe and click Open (or OK if you are using Windows 3.x).
3.

Follow the on-screen instructions to install the RSA files.

The operating program or .RSA file for each of the embroidery peripherals that supports the disk
drive will automatically load into the computer.

Configuring The EMT Disk Drive Controlled Unit
If you are operating from an EDS or Wilcom network as well as using the disk drive, install the
correct .RSA files as previously indicated and follow the rules of the network when assigning Unit
names to peripheral devices. Specifically, after setting the Peripheral Program, the Unit name must
be set differently for each peripheral attached to a single EDS System Controller.
If no network is attached to the EMT Disk Drive controlled embroidery peripheral, the Unit name
may be set to any name with 1-16 characters.

Operation
Booting The Peripheral
You may boot one of two ways. If the embroidery peripheral is properly configured and attached
to an EDS or Wilcom System containing the .RSA files, the peripheral will boot from the network
when the peripheral is powered up.

▲

If the peripheral is not connected to an EDS or Wilcom System, or if the system is not turned on
and operating in EDS or Wilcom, the peripheral will boot from the disk drive. A boot disk must be
in the disk drive. If a boot disk is not located in the disk drive, the message: INSERT BOOT DISK
will show on the display. Insert the boot disk and press and hold
for a moment. After
the machine boots correctly, it will display the model name.
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Loading a Design
Through the Network
After the embroidery peripheral is booted, you may load designs into the embroidery peripheral
buffer. If you are loading designs through the network, please refer to the EDS III Basic manual for
a detailed explanation of sending designs from the computer to the peripheral.

Through the Disk Drive
Once the embroidery peripheral is booted, you may load designs.
Directory Menu
1. Press
to display the Directory Menu. If the design format setting in the Options
Menu is correct, proceed to the next step. If the format is not correct, see the “Selecting the
Format” section below before you proceed.
.

▲

2. Place the diskette with the design to be loaded in the disk drive, then press

▲
▲

3. To load the design showing on the display, press
display is not the design you wish to load, press
design name is showing on the display, then press

▲

The name of the first design in the directory will show on the peripheral display.
. If the design name showing on the
or
until the desired
▼
.

▲

When
is pressed, the disk drive light comes on as the design is loaded into the
embroidery peripheral design buffer. While the design is being loaded, the display shows the
name of the design and that it is loading. When loading is complete, the display will show
DESIGN MENU.
Selecting the Format
Five formats of embroidery designs can be loaded into the peripheral by the EMT Disk Drive.
These formats are: DOS, TAJIMA, BARUDAN FMC, BARUDAN FDR, and ZSK.
Format Selection
If you need to change the format selection, go into the Options Menu, then press
to display Floppy disk format. Follow these steps to select a new format:
▼

▲

or

▼

▲

1. The currently selected format will show on the display. To change the selected format, press
or
until the correct format is displayed.
2. When the desired format is displayed, press
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Hooping
Proper hooping is essential for quality embroidery. The garment or fabric must be taut and flat,
and the weave or knit must be aligned. Follow these basic hooping guidelines to ensure proper
hooping:
•

Always hoop on a flat surface

•

Use the correct backing

•

Use the smallest hoop possible that will accommodate the design within the rack limits (see
the Trace menu for more information).

Mounting brackets
facing UP
(tubular hoop shown here)

•

Smooth the garment as much as possible before
hooping, including any lining or backing

•

Always check the back of the garment after
hooping to make sure there are no wrinkles or
parts which will be inadvertently sewn.

•

Do not over-tighten or over-stretch the material
in the hoop

•

Be sure the inner hoop does not extend past the outer hoop on the bottom; both rings of
the hoop should be evenly aligned

•

Practice

Figure 2-8

To hoop with a tubular or flat hoop, place the outer hoop on a clean, flat surface. Place the backing down, then the fabric, and then place the inner hoop inside the outer hoop with the mounting brackets facing UP (see Figure 2-8).
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Quick Start
The following section outlines the required steps to embroider a design.

Set home

Press
or

until the display reads FUNCTION MENU, then press
until the display reads SET HOME. Press
.

▼

▲

This is normally done on power-up; if the machine detects an error during its test sequence on
power-up, you must correct the error condition (e.g., if the machine is not at HEADUP, you must
GO TO HEADUP), then Set Home.
. Press

▲

Select hoop
▼

▲

▲
In the Options Menu, press
or ▼ until the display reads SELECT HOOP.
Press
or
to scroll to the proper hoop option.

Select orientation
▼

▲

▲
In the Options Menu, Press
or ▼ until the display reads Orientation Option. Press
or
to scroll through the orientation options. When the desired orientation is displayed, press
to continue.

Center hoop
In the Function Menu, press
CENTER?. Press

▲
or ▼ until the display reads GO TO HOOP
to center the hoop.
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Attach hoop
Tubular frames attach to the peripheral via the inner frame (see Figure 2-8). This allows the material to hang down around the frame without being sewn together during embroidery. Flat hoops
attach to the peripheral via the outer frame.
Tubular hoops
Refer to the following steps to attach the tubular hoop
to the peripheral:
1. Lower the sewing table by lifting the front of the
table and pulling it towards you. Place the tabletop
on the lower table supports (Figure 2-9) and push
the tabletop towards the rear of the machine. The
tabletop will snap into place.

Lower table
support

Figure 2-9
2. Attach the tubular frame support arms to the proper holes on the X-carriage for the selected hoop.
Use two thumb screws for each support arm (see
Figure 2-10). Make sure the clips (on the ends
where the tubular frame will attach) face UP.

Thumb screws

Figure 2-10
3. Insert the hoop frames by sliding the side brackets
underneath the spring clips on the support arms.
Make sure the slotted bracket (see Figure 2-11) is to
the right (as you are facing the machine). Slide the
hoop towards the rear of the machine until it snaps
into place.

Inner frame attaches
to peripheral
Slotted bracket

Figure 2-11
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Flat hoops
You can purchase an optional kit to embroider using flat hoops. Flat hoops attach to the peripheral via the outer frame and attach to the peripheral differently than tubular hoops.
Refer to the following steps to attach the flat hoop to the peripheral:
1. Raise the sewing table by lifting the front of the table and pulling it towards you. Place the
tabletop on the upper table supports (Figure 2-12)
and push the tabletop towards the rear of the
machine. The tabletop will snap into place.
2. Remove the tubular frame support arms from the
front of the X-carriage. Remove the two thumb
screws holding each support arm (refer to Figure
2-10).

Upper-table
support

3. Attach the flat hoop adapter bracket to the x-carriage using the thumb screws. Make sure the slotted end of the adapter is facing to the right.

Figure 2-12
4. Along the x-carriage (behind the needle case) are
the mounting locations for the flat hoops. The mounting brackets on the peripheral are
spring-loaded, so insert the right side (as you are facing the machine) of the hoop’s bracket
first, then push slightly to the right (to move the spring-loaded bracket). Insert the left side of
the hoop’s bracket next. Refer to Figures 2-13 and 2-14.

Flat hoop
mounting bracket (behind needle case)

Figure 2-13

Push the hoop to the right (as you
are facing the machine) then insert
the left side of the hoop

Figure 2-14
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Select a design

▲

▲

To select a design after it has been sent to the peripheral, press
until the display scrolls to
DESIGN MENU. Press
and the first design is displayed. Use ▲
to scroll forward or
▼
to scroll backward through the designs in the buffer. Scroll through the menu until you
reach the design you want. The LCD displays the name of the design, the stitch count, the number of colors in the design, and the current orientation that is selected. Press
to select
the design; the LCD displays the next menu.

Press

▲

Run Menu
to queue the design; the LCD displays the next idle menu.

Trace the Design

▲

▲

Note: Do NOT pull the needle or presser foot down to trace. Press
until
▲
▼
the display reads: FUNCTION MENU, then press
. Press
or
until the display shows Trace design outline?, then press
. The LCD will display
Calculating design outline. When the outline is calculated, it will display Trace
Design name and show you the needle number. Press
to initiate the trace function
and the pantograph will begin to move. The hoop moves along the outline of the design without
embroidering. The machine beeps and displays Rack Limit if a rack limit is encountered. The
beep means the needle will strike the hoop if sewn. To correct this, re-center the hoop,
select and use a larger hoop, or manually jog the hoop into position. Perform another trace after
you have corrected the problem.

Start Embroidering
▲

After the tracing function is finished, press
to get directly back to the
run mode again. Press
and the machine will move to the beginning of the
design. Press
again and the peripheral will embroider the design selected. The
embroidery will stop when the job is complete and the display reads: END OF DESIGN. To
stop the embroidery process before the design is complete, press
on the keypad. To continue after a stop or thread break repair, press
again.

Embroidery Speed
While the design is being embroidered you may change the speed of the machine by pressing
▲
or
.
▼
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Idle Display

The first display (Figure2-15) shows the
design name, the current sewing speed, the
current orientation, and the current needle
number.

at any time to see the Idle
to toggle between
▲

▲

While the machine is operating, you may press
display. There are two screens available in the Idle display; press
them.

Figure 2-15

The second display (Figure 2-16) shows the
stitch count, the selected sewing speed, the
needle number, and the percent complete.

Figure 2-16
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3. Accessories
Standard Cap Frames
Because a cap is not flat, it cannot be hooped in a flat hoop. To solve this problem, a special
device called a cap frame has been created to hoop caps. There are two sizes of cap frames:
7.0cm X 14.2cm (Large) and 6.3cm X 14.2cm (Small).
There are three parts to a cap frame:
•

The cap hoop

•

The cap frame driver

•

The cap frame gauge

Installing the Standard Cap Frame Driver
Follow these steps and consult Figures 3-1 and 3-2 to attach the cap frame.
1. Lower the tabletop to gain
access to the cap frame
mounting brackets under the
head.
2. Select the Large or Small
cap frame hoop size from
the Options Menu.
3. Press
to go to
the Function menu; select Go
to Hoop Center? and press
to center the hoop.
4. Under the cylinder arm,
locate these cap frame
mounting brackets:
•

The dove-tail bracket under the needle area

•

The rear mounting bracket.
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bracket
Thumb screw
Dove-tail mounting bracket

Figure 3-1
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5. Loosen the thumb screw on
the rear mounting bracket.

Side view

Front view

6. Loosen the thumb screw on
the dove tail bracket on cap
frame driver.
7. Pull the cap frame shaft
towards you, and attach the
hoop bracket to the carriage.
It attaches like a flat hoop.
8. Guide the cap frame shaft into
the hole in the rear mounting
bracket. At the same time,
insert the dove-tail bracket into the dove-tail mount.

Dove-tail
bracket

Thumb
screw

Figure 3-2

9. Push the cap frame shaft into the bracket hole until the silver ring on the shaft touches the
rear mounting bracket.
10. Tighten the thumb screw on the rear bracket.
11. Tighten the thumb screw on the dove-tail bracket.
12. Repeat this procedure for each head on a four-head peripheral.

First time adjustment
The first time you install the standard cap frame driver(s), you must adjust them to your peripheral
to ensure sew quality. Follow these steps to adjust the driver(s).
1. Install the drive(s) onto the head(s), if you have not.
2. Loosen the four button-head screws across the top of the drive bracket (see Figure 3-3).
3. Move the beam numerous times to the left and right extremes (x direction) to align the guide
bar in the ring drive slot.
4. Once the guide bar is aligned, move the beam so
that one of the screws is aligned with the needle
plate. Tighten this screw slightly.
5. Repeat step 4 for the remaining three screws.
6. Move the beam to the left and right extremes one
time. Repeat step 4 again, but this time, tighten the
screws fully.

Figure 3-3
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Using the Cap Hoop Gauge
Because the cap hoop is curved, it is difficult to control on a flat surface. The cap hoop gauge
clamps to a table edge to resolve this problem. Once the gauge is clamped, snap the cap hoop
into it to hoop the cap. Hoop the cap according to the instructions on the next page.

Hooping a Cap

Brim holder

To hoop a cap, follow these steps and
see Figure 3-4
1. With the latch on the left side,
open the cap frame and rest the
cover on the arm of the gauge.
2. Remove any cardboard or packing
material from the cap.
3. If the cap has a sweat band, pull it
to the outside. If the cap has a
braided cord, move it to the inside
of the cap.
4. If you are using backing, place it
inside the cap.

Figure 3-4

5. Slide the cap on the hoop frame so that:
•

The brim of the cap is away from you

•

The front of the cap is up

•

The sweat band is under the square retainer at the center of the frame

•

The sides of the cap are inside the outer arms of the cap frame

6. Push the cap onto the cap frame until the embroidery field is centered. Since caps come in different styles and sizes, you will have to determine how far forward the cap should be.
7. Hook the wire of the hoop latch over the catch, but do not fasten it.
8. Pull the cap as straight, fold free, and taut as possible.
9. Use your right hand to grasp the cap securely from underneath while fastening the frame
latch with your left hand.
10. Pull the elastic cord of the frame over the brim of the cap to secure it.
11. Snap the hoop out of the frame gauge.

12095 Rev. A

3. Accessories

3-4

Standard Cap Frames

12. Install the cap frame on the cap frame driver by aligning the frame and the driver, then snapping the frame slots under the roller clamps on the driver.
13. Repeat this procedure for each head on a four-head peripheral.

Raised needle plates
Raised needle plates improve embroidery quality on caps. When cap frames are attached, the
curve of the frame leaves extra space between the cap and the needle plate. To eliminate the
space and ensure high-quality embroidery, a qualified operator or maintenance person should
install raised needle plates as described below. See Figure 3-5.
Note: When using a raised needle plate, use spacers to raise the presser foot.
1. Remove the two screws attaching the standard needle plate and replace the standard plate
with the raised plate. Use the same screws to attach the raised needle plate. The needle
should be centered in the hole in the raised needle plate.
2. Remove the lower cover on the front of the needle case. It is not necessary to remove any
thread.
3. Using a small flat-bladed screwdriver,
push the standard spacer up to the top
of the presser foot assembly (see Figure
3-5).
4. Shim spacers come in two thicknesses:
0.020" and 0.040". Each shim spacer
has five holes; cut two single hole sections (refer to Figure 3-6). The raised
needle plates are 0.090" higher than a
standard needle plate, so you should
add two 0.040" spacers to the sewing
head.

Add the extra spacers
beneath the standard shims.

Lower
cover

Figure 3-5
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5. The spacers must be cut prior to installation. The
Spacers come with 5 holes; refer to Figure 3-6 for
the correct area to cut to make a single spacer.
Then, cut one side of the spacer so it will fit around
the needle bar.

Cut along all dotted lines

6. Slide the spacer (with the cut side facing upward)
in between the presser foot and the needle bar.
Use a small flat-bladed screwdriver to push the
spacer over the needle bar.

8. Press

from the Main menu and the display shows: HEAD TIMING MENU.
▲

7. Press

Figure 3-6

and the display shows: HEAD TIMING ON.
▲

9. Press
. The machine rotates to the “Head up” position and the display
shows: ONE REVOLUTION 110.0.
▼
10. Press
. The head rotates to “Needle Depth”. The presser foot should be 0.040"
from the needle plate.

11. Verify the presser foot is clearing the needle plate by 0.030 to 0.050". If needed, add or
remove the necessary combination of the 0.020 or 0.040 spacers to achieve the appropriate
clearance. Go to step #9 to rotate the machine to HEADUP to add or remove spacers.
Note: If you add too many spacers, you may overcompress the presser foot springs and damage
the springs or impair the quality of the embroidery.
12. Replace the lower needle case cover.
13. Press
to exit the Head Timing Menu; then press
the Main menu.

to return to

When you return to sewing flat or tubular goods, reverse the above procedure to remove the
raised needle plates and the extra spacers.

12095 Rev. A

3. Accessories

3-6

Wide-Angle Cap Frame

Wide-angle cap frame
The Wide-angle cap frame option allows you to embroider on nearly 270° of a cap’s crown and
includes:
•

The cap hoop

•

The cap frame driver

•

The cap frame gauge

First time installation and adjustment
The first time you install the wide-angle cap frame
driver on an EMT peripheral, you must perform the
following adjustment; failure to do so will result in
an excessive wear to the cap frame driver and
reduced embroidery quality.

Screws

1. Remove or lower tabletop inserts.
2. Make sure that the cap supports are extended; if
they are not, extend them (refer to the Technical
manual for more information).
3. Make sure that the 3 socket-head cap screws
along the interface bracket (Figure 3-7) and 4
socket-head cap screws which hold the bearing
housing (Figure 3-8) are slightly loose.
4. Move the beam all the way back (towards the
rear of the peripheral) using the peripheral keypad.
5. Install the driver; guide the cap driver shaft into
the hole in the rear mounting bracket. At the
same time, insert the driver dove-tail support
bracket into the female dovetail mounting bracket. Refer to
Figure 3-9.

Figure 3-7

Screws

Bearing
housing

Figure 3-8

Rear mounting
bracket

6. Push the cap driver shaft into
the hole in the rear mounting
bracket until it reaches the positive stop.

Thumb screw
Dove-tail mounting bracket

Figure 3-9
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Note: When pushing the driver shaft into the hole in
the rear mounting bracket, make sure the cap
supports are positioned over the needle plate.
This prevents the shaft from binding.

Driver bar

7. Tighten the thumb screws on the rear mounting
bracket and on driver dove-tail support bracket (see
Figure 3-10).
8. Position the driver cap supports on the needle plate
(see Figure 3-11), center them to the needle plate
hole and in the same time adjust their position in
up-down direction by moving driver up-down on
the slots in the bearing housing and slightly tighten
at least one socket cap screw on the bearing housing using 4mm hex allen wrench. The cap supports should touch the needle plate lightly and
the driver should slide freely from front to back
without any restriction; the cap supports should
not have any visible side to side movement.

Thumb screw

Figure 3-10

Cap
Support

9. Push on the driver bar to move the driver from
front to back several times, making sure the driver moves freely. Tighten all 4 screws on the
bearing housing.

Figure 3-11

10. Using the peripheral keypad, move the beam to
the front of machine and connect the cap driver to the beam using the two hoop interface
thumb screws.
11. Tighten the 3 socket-head cap screws along the interface bracket until they barely contact the
bracket using provided 3mm short arm hex allen wrench. The interface bracket should still be
able to move in up-down direction. Refer to Figure 3-7 for screw locations.
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12. Level the interface bracket. To do this, first
move the beam all the way to the left, by
pushing on the X-carriage. Make sure that
there is no gap between the driver bar and
driver ring (see Figure 3-12). If needed, press
down lightly on the bar and tighten the corresponding socket-head cap screw on the
interface bracket slightly. Then, by pushing on
the X-carriage, move the beam all the way to
the right and repeat the procedure.

Driver bar

Check for
contact here

Driver ring

Figure 3-12

13. Repeat moving the driver all the way to right and left, watching closely to ensure that the driver bar firmly contacts the driver ring and moves with no visible restriction. If the driver bar
does not firmly contact the drive ring, loosen the 3 socket-head cap screws and repeat step
14.
14. Carefully and firmly tighten all 3 socket-head cap screws along the interface bracket without
allowing the bracket to move.
15. Press
to go to the Function menu; select Go to Hoop Center? and press
to center the hoop.
Your wide-angle cap frame driver(s) are fully adjusted and ready for use.
IMPORTANT
If you wish to use the adjusted cap frame option on a different peripheral, check the adjustment
on the new peripheral to ensure proper sew quality.
This adjustment only needs to be performed the first time the cap frame driver is installed on a
machine. The Wide-angle cap frame does NOT require the use of raised needle plates.
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Installing the wide-angle cap frame driver
The steps in this section describe how to install the driver after it has been previously installed and
adjusted. If you have not installed the driver previously, refer to the First Time Installation and
Adjustment section. To install the cap frame driver on an EMT peripheral, follow these steps:
1. Lower the tabletop to gain access to the cap frame driver mounting brackets under the head.
2. The Wide-angle cap frame hoop size will be automatically selected.
3. Press
to go to the Function menu; select Go to Hoop Center? and press
to center the hoop.
4. Under the cylinder arm, locate the cap frame mounting brackets (see Figure 3-13):
•

The female dove-tail mounting bracket under the needle area

•

The rear mounting bracket

5. Loosen the thumb screw on the
rear mounting bracket.
6. Loosen the thumb screw on the
male dove tail bracket on cap
frame driver (Figure 3-14).
Note: When pushing the driver
shaft into the hole in the
rear mounting bracket,
make sure the cap supports
are positioned over the
needle plate. This prevents
the shaft from binding.

Rear mounting
bracket
Thumb screw
Dove-tail mounting bracket

Figure 3-13
Driver bar

7. Guide the cap driver shaft into the hole in the rear
mounting bracket. At the same time, insert the male
dove-tail bracket into the female dove-tail mounting
bracket.

Thumb screw

Figure 3-14
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8. Connect the wide-angle cap frame driver to the x-carriage using the hoop interface thumb
screws.
9. Push the cap frame driver shaft into the bracket hole as far as possible.
10. Tighten the thumb screw on the rear bracket.
11. Tighten the thumb screw on the male dove-tail bracket.
Note: The first time you install the wide-angle cap frame driver on the peripheral, perform the
adjustment procedure in the previous section.

Tip

Always install the driver on the mounting brackets first, and then attach the driver to the
beam. This will improve the quality of your embroidery.

The tensioner disk
To install the tensioner disk, follow these steps:
1. Loosen the two thumb nuts on the back of the wide-angle cap frame driver (see Figure 3-15).
2. Insert the tensioner guides into the two
holes in the front of the wide-angle cap
frame driver (through the two thumb nuts
on the rear).
3. Tighten the two thumb nuts.
Figure 3-16 shows an installed tensioner.
Note: You may need to adjust the tensioner
slightly to provide optimal tension for
caps with different crown heights.
Simply loosen the thumb nuts and slide
the tensioner to its appropriate location,
then retighten the thumb nuts.

Thumb nuts

Figure 3-15

Reverse these steps to remove the tensioner.

Tensioner

Figure 3-16
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The cap frame gauge
To install the cap frame gauge, tighten the
clamp until the gauge is held firmly. Figure 3-17
shows a mounted cap frame gauge.

Figure 3-17

Hooping with the wide-angle cap frame
Hooping on a wide-angle cap frame should be as straight-forward and simple as hooping on a
regular cap frame. Follow the steps outlined below to hoop on your wide-angle cap frame:
1

2

3

First, attach the cap gauge to a stable
surface.

The cap frame has a metal strap, with
a buckle at its end. Make sure this
buckle is attached by screws in its
OUTSIDE two holes, NOT the inside
two holes.

4

5

For the best sew quality, use the rubber strip; it provides appropriate spacing and hoop tension. Drape the strip
over the gauge...
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...placing the ends BETWEEN these
clip posts and the cap gauge.

Now, slide the cap frame onto the
gauge, making sure the locating element on the cap gauge fits into the
cap frame's notch, and the cap frame
slips firmly under the two roller clips.

6

Appropriate backing can now be
placed around the rubber strip. The
backing stays OUTSIDE the posts and
is pushed BENEATH the locator. You
may use several layers of backing.
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7

8

Next, prepare the cap for sewing.
Open the back fastener.

Lower the sweatband completely.

10

11

If the braid has a tail on the inside,
trim it short to keep it clear of
embroidery. Leave only about 1/4" of
braid from where it's sewn to the
cap.

Now place the cap on the cap frame.
The sweatband should be under the
locator, and the brim should be centered and pointing up.

13

14

Flatten any "bunching" of the sweatband by folding it over and toward
the hoop.

To secure the sweatband, swing the
metal strap up and over the sweatband and the cap's brim.

Operation Manual for the EMT 1

9

If the cap has a braid, move it around
the cap to the inside and under the
brim as shown.

12

Pull the side of the sweatband
toward the cap frame and down.

15

Close the metal strap, making sure
one band of the strap fits in the
groove on the locator...and the other
band lies cleanly along the brim
edge.
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17

To achieve a snug fit of the cap
frame's metal straps, perform step
17 whenever you change cap
styles.
Step 17 does not need to be
performed if the cap style has not
changed. In this case, simply latch
and close the buckle.
Loosen the wing nuts on the strap,
latch and close the buckle...then push
down on the strap above the wing
nuts with a hard tool. Use MODERATE pressure when doing this.
Retighten the wing nuts.

18

20
Tip

19

Pull the elastic brim holders over the
cap's brim to the front. Pull the wrinkles out of the cap using light tension. To secure the cap fabric, attach
two clips...

...to each post. The clips are applied
with the handles angled down and
toward the center of the cap.

You may now remove the cap hoop
from the gauge. Remember to also
remove the rubber strip. Your cap is
now properly hooped.

IP
LT
A
I
C
SPE

±
Make sure the posts are aligned
properly with the center of the cap
frame.

±
If they look like this, readjust them.

If the posts are bent and touching
the cap gauge, bend them back into
position.

This is how they should look!
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Place the hooped cap on the driver
Unclip the 3 clamps on the cap frame driver (see
Figure 3-18). Slide the frame onto the driver,
snapping it into place. Secure the 3 clamps on
the driver.
Check the bobbin thread before you install the
frame with a cap attached; if you run out of
bobbin thread you must remove the cap frame
in order to change the bobbin. This may result
in lost registration.

Figure 3-18

Using the tensioner disk
The tensioner disk attaches to the cap frame driver and increases tension in the crown of the
cap during embroidery. This additional tension
helps improve embroidery quality, particularly on
non-structured caps. The tensioner disk also
increases embroidery quality on slouch and
short-crowned caps, but because the tensioner
disk reduces the embroidery field’s height by
approximately 0.23in (6mm) you may not be
able to use the tensioner disk without modifying
the design to reduce overall height.

Figure 3-19

If you try to use the tensioner disk without compensating for the height of the design, you will
see reduced embroidery quality near the top of the design. The tensioner disk will contact the
needle plate and prevent the beam from moving as far as is needed for the design height.
The tensioner disk needs to be adjusted differently for each type of cap used on your peripheral.
To adjust the tensioner disk, simply loosen the thumb nuts and slide the tensioner disk in or out,
then retighten the thumb nuts (see Figure 3-19). The disk should push the crown of the cap out
slightly (increasing the tension). There is not a “rule of adjustment” because of the variety of caps
available today.
Do not adjust the tensioner disk to fit so tightly that the spring (pushing the disk out) is completely compressed. If you do, the tensioner disk may restrict the cap’s movement during embroidery,
resulting in a loss of registration and reduced embroidery quality.
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Sewing field
The height of the sewing field varies on caps because of the variation in crown sizes. You can use
the following formulas to calculate the height of the sewing field for different crown sizes:

Y=A - 1.18
X=14.25"

Where:
Y= height of the sewing field in inches
A=height of the crown in inches

Y=A - 30
X=362mm

Where:
Y= height of the sewing field in millimeters
A=height of the crown in millimeters

Remember, if you are planning to use the tensioner it reduces the embroidery field’s height
by approximately 0.23in (6mm).
Tip
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Cap designs
Designs that embroider well on flats may not embroider as well on caps because of the uneven
tension a cap frame provides. Here are some ideas to help improve embroidery quality on your
wide-angle cap frame:
•

To help eliminate slippage, digitize from the center out; start in the center of the design
and embroider one side of the cap then return to the center and embroider the other.

•

Complete entire design elements as you go around the side; for example, if you have lettering with shading, embroider a letter, then its shading, then move on. This helps to eliminate the push-pull tendency of the fabric of the cap. Underlays should follow this rule,
too.

•

If you have a lot of running stitches in a design, consider converting them to satin stitches.
Running stitches have a tendency to lose registration.

•

With large designs, try to alternate the direction of the stitches. This helps to eliminate the
push-pull tendency of the fabric of the cap.

•

Use more underlay stitches to help stabilize the design and prevent distortion. Six panel
caps need more underlay in the center where the seam is.

•

Using a fusible non-woven backing on six panel caps helps hold the two front panels firmly together.

Modifying your designs to embroider on caps may give you more color changes, but it will also
provide you with much better embroidery quality.

The Sash Frame
The sash frame is an aluminum rectangle that attaches across the full length of the x-carriage,
using the tabletops for support. The material is held in place by fabric clips included with the sash
frame. The sash frame has a maximum embroidery field per head of 11.02" x 19.69" (28cm x
50cm) for the EMT 1.
Often, only the backing material is hooped in the sash frame, and several smaller pieces of fabric
are fixed on top of the backing with a non-permanent fabric adhesive. This procedure reduces
hooping time and permits a high rate of production on parts of preassembled garments like
labels, patches, collars, and pockets.
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Mounting holes

Follow these instructions and see Figure 320.
1. Before installing the sash frame, make
sure the tabletop is in place. Without
the support of the tabletop, the sash
frame may be damaged.
2. Guide the sash frame under the head
with the mounting holes toward the xcarriage.
3. Match the sash frame mounting holes
with the holes on the x-carriage and
insert the thumb screws into the corresponding holes on the x-carriage.

Figure 3-20

4. Tighten the screws when they are all in place.

Storing the Sash Frame
The sash frame will not operate properly if it is bent. Suspend the frame lengthwise when not in
use.

Hoop Selection
Before embroidering with the sash frame, Select Hoop in the Options Menu to either the sash
frame or a spider hoop (if appropriate). Failure to do so may damage the peripheral.
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Hooping on the Sash Frame
The same hooping guidelines apply to the sash frame as to regular hooping.
1. Lay the fabric over the sash frame as flat as possible.
2. Attach the first clip on the x-carriage side of the frame near a corner. The thumb rail should
be facing away from the embroidery field.
3. Attach 1-220cm clip and 1-300cm clip along the back of the frame.
4. Pull the fabric taut and attach the same number of clips at the front of the frame.
5. Attach one 220cm clip to each end of the frame.

Spider Hoops
A spider is a hoop that holds another hoop. Spider hoops attach to the peripheral and allow garments to be hooped individually without removing the frame. The outermost hoop has brackets
that attach to the beam
There are two spider hoop options available. One option attaches to the sash frame, and one
option attaches to the peripheral the same way a flat hoop does.
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To install spider hoops on the sash frame:
1. Attach the thumb screws for the spider hoop into the sash frame, but do not tighten yet.
2. Remove the inner hoop from the 21cm hoop with the two brackets (shown in Figure 3-21).
3. Insert the spider hoop you plan to use so that the opening in the spider for the hoop tightener
is centered on the bracket with the back-facing slot (Bracket A in Figure 3-21). Secure the spider with the 21cm hoop tightener.

Bracket A

Opening for the
hoop tightener

21cm hoop tightener

Bracket B

Figure 3-21
4. Referring to Figure 3-21, slide bracket A into place on the thumb screw at the rear of the sash
frame, then swing bracket B into place on the thumb screw at the front of the sash frame.
5. Tighten the thumb screws.
Note: After using the spider hoops and BEFORE embroidering with the full sash frame
(no spider hoops attached) remove the thumb screws or the machine may be
damaged.
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Lamp
The EMT 1 comes with a flexible lamp attached to
the table. The lamp has a separate ON/OFF switch
located on the bulb case (Figure 3-22). Push to turn
the lamp ON or OFF.
To change the bulb, turn the power off, then
unscrew the bulb case (refer to Figure 3-22). Use a
12V/20W halogen bulb (one is provided in the operator kit).
Note: Wash your hands before handling the halogen
bulb; oil and grease can damage the bulb.

ON/OFF
switch

Figure 3-22

Bobbin Winder
The Bobbin Winder is available in two basic configurations: as a built in feature of the EMT 1 and
as a stand-alone option. See Figures 3-23 and 3-24.

Built-in
bobbin winder

Stand-alone
bobbin
winder

Figure 3-23
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Thread Selection
Although all standard embroidery threads may be used as an under or bobbin thread, embroidery
results vary depending on the thread weight and composition selected. Thin, weak threads will
increase thread breakage problems. Conversely, thick, slick-finish threads may produce problems
with the stitch quality of finished embroidery. Bobbin tension requires adjustment for good
embroidery with any thread. The weight of the thread selected and the tension used when winding will also determine the amount of thread on the bobbin and therefore the frequency of bobbin changes. For most applications, a cotton thread or a core spun cotton composition thread
(such as RASANT) in a 40 or 50 weight (DTEX numbers 135x2 and 128x2 respectively) is recommended.

Operation
1. Thread the winder as shown in
Figure 3-25. The arrows on the
base plate indicate the direction
of the thread path.
2. Place an empty bobbin spool (P/N
008499-01) on the winder shaft
and make 6-8 tight wraps of
thread around the spool in the
direction shown. Break or trim off
the thread tail close to the spool.
3. Move the actuator lever to the
ON position (see Figure 3-26) and
winding will begin. The winder
automatically stops when the bobbin is
wound completely.

Figure 3-25

Actuator lever
Move in the direction indicated

Figure 3-26
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Note: To set the level of fill, adjust the position of the Bobbin Full switch on the actuator lever
using the two screws on top of the lever. The level of fill should be set to approximately
80% of the bobbin capacity or about 0.04" [1mm] below the edge of the spool flange.
4. Move the actuator lever to the OFF position, remove the wound bobbin and break or trim the
thread tail.
A properly wound bobbin is shown in Figure 3-27 (item A). Items B through E in Figure 3-27 show
improperly wound bobbins. Adjust the winder tension, the thread path or the Bobbin Full switch
to correct winder operation if you are experiencing any of the situations shown below.

Figure 3-27
Motor Protection
The bobbin winder motor is equipped with a
thermal switch to protect the motor and drive circuitry in the event of an overload condition. If the
bobbin winder stops due to an overload, follow
these steps to correct the problem:
1. Move the actuator lever to the OFF position.
2. Clear the obstruction and lubricate the drive
shaft (refer to Figure 3-28).
3. When the motor cools, the thermal switch
will automatically reset.
4. Move the actuator lever to the ON position to
resume operation.
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Bobbins
The bobbin winder is designed for use with the
aluminum bobbin spool (p/n 008499-01) provided
with the unit. If bobbin spools from other sources
are used, the bobbin may be improperly retained
on the bobbin winder shaft. Most non-standard
bobbin spools have a slot in the spool hub that
engages the bobbin winder shaft spring and
holds the bobbin in place. If this type of bobbin
spool is used, you must reposition the shaft
spring. Refer to Figure 3-29 and follow the steps
below:
1. Use a needle to disengage the spring from
the standard (upper) hole in the shaft.

Upper
hole

Lower hole

Figure 3-29

2. Slide the spring into the shaft until the spring tail snaps into the second (lower) retaining hole.
3. This is the operating position for slotted hub bobbin spools.

Bobbin Winder Maintenance
When the bobbin winder is subjected to heavy or
continuous operation, you may need to lubricate
the bobbin winder shaft. Apply one drop of
sewing machine oil to the bobbin winder shaft as
shown in Figure 3-30. Rotate the bobbin winder
shaft by hand until the shaft moves smoothly and
freely.

Oil here

Figure 3-30
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4. Operator Maintenance
This chapter outlines machine maintenance; in addition, operators and maintenance personnel
must attend a Melco approved training course prior to maintaining the machine.

Installing a Needle
Each needle has a needle clamp set screw holding it in place as shown in Figure 4-1. Use the
small flat-blade screw driver from the tool kit
and follow these steps to replace a needle:
1. Turn the set screw counterclockwise until
the needle can slide down and out of the
needle bar. Do not remove the set screw.
2. With the scarf of the new needle toward
the rear of the head, slide the needle into
the needle bar as far as it will go, and retighten the set screw. The eye of the needle
should be facing directly forward.

Figure 4-1

Cleaning
Work area
The work area around your peripheral should be kept orderly and clutter-free at all times.>

Exterior Surfaces
Clean outer plastic surfaces once per month with a soft, clean cloth, a mild detergent and water.
Wring out the cloth before wiping the surfaces. Do not get water or any other fluids inside the
machine or on any of the working mechanical surfaces.
Note: If an accidental spill occurs, wipe it up immediately with a clean dry cloth and allow the
machine to dry completely before turning the power on.
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The Rotary Hook Area
1. Clean this area once per month with the machine power OFF.
2. Remove the 2 needle plate screws and lift off the needle plate.
3. Clean the exposed area with the brush supplied in the operator kit, and use compressed air to
blow any debris from the area.
Note: Depending on the type of material being used, this area may require cleaning more often.
Some high-lint materials will require this area to be cleaned once per day for peak performance.

Lubrication
The EMT 1 requires regular maintenance to perform its best. A message will display at the end of
each design when it is time for maintenance. Press
to enter the Service/
Maintenance menus (HEAD TIMING MENU will be displayed). Press
to scroll to the
required menu to perform the maintenance. Any necessary tools are provided in the operator kit.
You can use a light-duty sewing oil (available from Accessory Resource Corporation) to lubricate
your peripheral; a small bottle is provided in the operator kit.
Note: Before you perform any lubrication on the peripheral, you should remove any garment
from the machine. Also, for every lubrication menu except the 8 hour menu you should
remove the hoop; the eight hour menu moves the cap frame driver to distribute the oil, so
it must be attached to the peripheral. And because the maintenance program requires
rack movement in most menus, your current start position will be lost.
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▲

▲

Press
to step through the menu. Each time you press
, the machine will move to its
next position. Refer to these pages to oil each component throughout the process. When you
have completely stepped through each menu, the display will be cleared.
The message will display at the end of each design. You can press any key to temporarily clear the
message, but you must perform the required maintenance to clear the message (until the maintenance is required again). Use the oil provided in the operator kit.
Due to software limitations, you may experience multiple lubrication messages for different lubrication intervals. For example, you may perform the 40 hour maintenance, sew a design, and have
to perform the 80 hour maintenance. The reason for this is that the counter, which logs the time
for each message, is not reset until you perform the maintenance.
Refer to this section for lubrication information. Follow the steps outlined below for each message.
Time to oil hook

Put 1 drop of oil
on as shown

▲

▲

▲

When this message appears, go into the 4
hour lubrication menu and press
.
When hook appears, press
. This
causes the z axis to move the hook to its proper position for oiling (250°). Refer to Figure 4-3
to lubricate the hook. Press
when
done.
You must perform this operation to clear the
message.

Figure 4-3
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8hr maintenance due
This time will only accumulate when a cap frame is in use. You must perform this operation to
clear the message. You may leave the driver attached to the peripheral to perform these maintenance steps.

▲

▲

▲

If you are using a Large or Small Cap Frame,
go into the 8 hour lubrication menu then
▲
press
. Press
or ▼ until
cap driver shaft appears, then press
.
This causes the y axis beam to move the cap
frame to the correct position for oiling. Use 1
drop of oil on each side of the shaft (refer to
Figure 4-4 to lubricate the cap frame driver
shaft). Press
when done. The y-rail
will move back and forth to distribute the oil.

Figure 4-4

Wipe the lint
off both shafts

▲

▲

If you are using a Wide-Angle Cap Frame, go
into the 8 hour lubrication menu then press
▲
. Press
or
until wide▼
angle driver shaft guide appears, then press
; the x-carriage will move to the front.
Wipe the lint off both driver shafts (see Figure
4-5). Place one drop of oil on the Driver shaft
guide (the bottom shaft) as close to the cap
frame driver as possible, then press
to
move the x-carriage to the rear. Wipe the lint
off both shafts. Place one drop of oil on the driver shaft guide at the plastic pad (see Figure 46). Press
when done. The x-carriage will move back and forth to distribute the
oil.
▲

Driver
shaft guide

▲

Figure 4-5

Plastic
pad

Figure 4-6
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When this message appears, go into the 40 hour lubrication menu, then press

▲

40hr maintenance due
.

▲

▲

When upper connecting rod displays, press
. This moves the needle to its proper
position for oiling (201° of z axis). Remove the front cover on the EMT 1 (it will slide to either
side, and is attached with magnets). Figure 4-7 shows the lubrication hole inside the machine.
Replace the front cover after lubrication. Press
when done.
You must perform this operation to clear the message.

Upper connecting rod
lubrication location

Figure 4-7
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80hr maintenance due
▲

When this message appears, go into the 80
hour lubrication menu, then press
Refer to the steps below to lubricate each
area.
Note: If you have a cap frame driver
attached, you must remove it before
stepping through this menu.

▲

▲

1. When upper/lower needle bar displays,
press
. No motion is required.
Remove the front cover on the EMT 1 (it
will slide to either side, and is attached
with magnets). Place 2-3 drops of oil on
the needle bar in each location shown in
Figure 4-8. The needle bar will be visible
through the slot (use a flashlight if necessary). Replace the front cover after lubrication. Press
when done.

Figure 4-8

▲

▲

2. When needle bar driver displays, press
. There is a small black plastic
cover centered at the top of the head.
Remove the cover; the needle bar driver will
be visible through the hole. Place 2-3 drops
of oil on the needle bar driver inside the
hole (refer to Figure 4-9) Replace the black
cover after lubrication. Press
when done.

Figure 4-9
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▲

▲

3. When lower connecting rod displays, press
. This moves the z axis to its proper
position for oiling (150°). Place 2-3 drops of oil in the location shown in Figure 4-10. Use a
flashlight if needed. Press
when done.

Figure 4-10
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▲

▲

4. When y-rails is displayed, press
. This moves the y-rail into its proper position for oiling. Refer to Figures 4-11 and 4-12 to lubricate the y-rail. Press
when done
(the y-rail will move back and forth to distribute the oil).
Note: The y-rails are not located directly under the slot. you must angle the oiler slightly toward
the middle of the machine to reach the rails. Figure 4-12 shows the location of the rails
(with the side panel removed).

Place 1-2 drops on
both the front and the back
of the y-rail through this
slot. Repeat for the left side
of the machine

Figure 4-11

Figure 4-12
This completes the 80 hour maintenance. You must perform ALL operations to clear the message.
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480hr maintenance due
▲

▲

When this message appears, go into the 480 hour lubrication
menu, then press
. When x axis displays, press
. This causes the x beam to move to the correct position for oiling.
Before you can oil the x-carriage, you must remove the aluminum
cover; there are 6 screws along the top of the cover. Remove all 6
screws, then carefully lift the cover off the x-carriage.

Figure 4-13

The x-carriage is a metal beam with a groove along
the front and back (along the top edge). When you
oil the x-carriage, make sure you put one drop
of oil in the groove on each side of the metal
beam. Figure 4-13 shows the groove along the
front of the x-carriage; there is another groove on
the back side of this beam. Refer to Figure 4-14 to
lubricate the x-carriage.
▲

Press
when done. The x-carriage will move
back and forth to distribute the oil.

Oil at each
location

Figure 4-14
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2100hr maintenance due
▲

When this message appears, go into the 2100
hour lubrication menu, then press
.
Refer to the steps below to lubricate each
area.

Press

▲

▲

1. When take-up lever cam and follower
displays, press
. Remove the 4
screws shown in Figure 4-15, and set
them aside. Remove the saddle bags. The
take-up lever cam and follower is located
directly behind the head. Use a cotton
swab and a SMALL AMOUNT OF GREASE
to lubricate the take-up lever cam and follower (refer to Figure 4-16). Use a flashlight if necessary. Replace the saddle bags
and tighten the 4 screws.

Figure 4-15

when done.

Figure 4-16
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3. If you are using a Wide-Angle Cap Frame,
the message Wide-Angle Driver Shaft will
appear; press
. Remove the
wide-angle driver from the peripheral. Wipe
the lint off the driver shaft (see Figure 4-17).
▲

Driver
shaft

Figure 4-17
Loosen the 2 screws holding the rear support bracket using the 2mm hex wrench
(see Figure 4-18).

Screw
holes

Remove the rear support bracket.

Figure 4-18
Pull the driver shaft and driver shaft guide
out the front of the driver until the bearings
are exposed (see Figure 4-19).

Open
bearings

Place 10 drops of oil on the bearings.
Push the driver shaft and driver shaft guide
up through the bearing housing.

Press

▲

Attach the rear support bracket and tighten
the 2 screws.

Figure 4-19

when done.

You must perform all operations to clear the message.
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Replacement Parts
Fuses
There are two operator-replaceable fuses. If a fuse must be replaced, use this chart for appropriate
fuse ratings. Do not use a fuse with any rating other than what is listed here:

PERIPHERAL
EMT 1

115V RATING (Melco part number)
5.0 A (010162-05)

230V RATING (Melco part number)
2.5 A (010162-25)

To replace a fuse, follow these steps:
Plastic cover
1. Turn off the power and disconnect the power cord.
2. Directly above where the power cord plugs in is a small
plastic cover (see Figure 4-20). Use your fingernails to
unclip each side of this cover in the locations shown in
Figure 4-20.
3. When the cover is unclipped, pull on the cover to
remove the fuse holder (see Figure 4-21).

Figure 4-20

4. Change the fuses, then replace the fuse holder.

5. Reconnect the power cord and turn on the power.

Figure 4-21

Tool Kit
The tool kit contains the following items and is included in the operator’s kit:

12-piece standard ball hex set
Phillips #2 screwdriver
Straight small screwdriver
Phillips offset screwdriver
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Right angle screwdriver
Short straight screwdriver
Tool handle
Tool extension

1/16” ball allen wrench
9/64” ball allen wrench
5/23 ball allen wrench
6-piece metric ball hex set
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Operator Kit
The contents of the operator’s kit for the EMT 1 are listed here:

PART NUMBER
761003-01
010969-01
761008-01
006846-01
110113-01
001532-01
005577-01
001528-01
001537-01
007559-01
007591-01
861689-01
010970-01
007505-01
005917-01
110191-01
110342-01
110344-01
110343-01
009692-01
010918-01
005157-01
110345-01
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DESCRIPTION
OILER
NEEDLE, ORGAN, 80/12, SHARP, DB X
BRUSH, LINT
KIT, TOOL, UNIVERSAL
WARRANTY, STATEMENT, LIMITED, 12 M
BAR, NDL
BUMPER, WASHER
CLAMP, NDL, ASSY
SPRING, HLDING, NDL BAR
SPRING, CHECK, TNSNR, THD
DAMPER, NDL CLAMP
LUBRICANT, GREASE T517, 2 OZ
NEEDLE, ORGAN, 80/12, BALL, DB X
SHIM, NDL CS
DISK, RSA FILES (1 DISKETTE), ED
ABOUT YOUR TRAINING
MANUAL, OPRTR, EMT 1
MANUAL, TECHNICAL, EMT 1
MANUAL, ILLUST PARTS, EMT 1
BULB, HALOGEN, 12V
TEMPLATE KEYPAD, EMT 10T
DISK, BOOT, DSK DRV OPT, (4 DISKETTES)
NOTES, RELEASE, RSA
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Spare Parts
To help reduce down-time, Melco suggests keeping certain spare parts on hand for easy replacement and maintenance. Melco provides a Spare Parts kit (p/n 10906); it contains the following
items:
Note: The spare parts kit for older EMT 1s (machines that pre-date spring 1998) is part number
011034-01. It includes the same items as those listed below, but also includes a Fuse Kit.
Confirm your serial number with your Melco Representative to verify which kit is right or
your machine.

PART NUMBER
010369-01
10871
10711
009419-01
009000-01
004267-01
007924-01
005617-01
009411-01
010107-01
344924-01
005600-01
006671-01
008471-01
007505-01
110138-01
001532-01
001840-01
003586-01
001528-01
004643-01
341992-06
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DESCRIPTION
CABLE, ETHERNET, NTWRK, INTFC
PCB, KYBD W/ KEYCAPS, DISPLAY, EMT, ASSY
PCB, CPU, ASSY
PCB, MOTOR DRIVER, EMT10, ASSY
HOOK, ROTARY, SM BOBBIN
CASE, BOBBIN
FOOT, PRESSER, ASSY
KNIFE, MOVABLE
PCB, CLR CHNG, EMT, ASSY
UTC, ASSY
STRAP, WRIST, STATIC
KNIFE, SPRING, FIXED
PRESSER UNDER THREAD
VELCRO, GRABBER, FLARRED
SHIM, NDL, CS
LIST, HARDWARE, SPARE
BAR, NDL
CLAMP, STOP, NDL BAR
BLADE, GRABBER
CLAMP, STOP, NDL BAR
SCREW, NDL PLATE
SCREW, FIXING ROTARY HOOK
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5. Troubleshooting Guide
Thread breakage
PROBLEM

POSSIBLE CAUSES

SOLUTIONS

Design

Stitches are too short and/or too
dense

Needles

Incorrect needle for thread size
being used
Needle is bent, damaged, or dull
Needle position is incorrect

Check the design for short and/or
dense stitches, and edit the
design to remove them
Replace with a compatible needle

Thread

Needle scarf and/or needle eye is
burred
Incorrect thread size for the
needle being used
Poor quality thread

S-twist (right twist) thread being
used
Improper threading
Upper/bobbin
tension

Upper/bobbin tension too tight

Fabric and hoops

Ratio of upper thread to bobbin
thread incorrect
Incorrect check spring
tension/stroke
Fabric is hooped loosely

Rotary hook

Inadequate backing allows fabric
to pull into needle plate hole
Hook timing is incorrect

Thread path

Rotary hook does not rotate
smoothly
Bobbin is damaged
Bobbin thread feeds poorly
Scratches or burrs on thread path

Needle depth

Needle depth is incorrect

Bobbin
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Replace needle
Install the needle correctly (see
needle installation)
Replace needle
Replace with a compatible needle
Replace with a high quality
thread or spray silicone on thread
cone
Replace with a Z-twist (left twist)
thread
Thread correctly (refer to
threading section)
Loosen upper/bobbin tension
Adjust upper and/or bobbin
tension (see tension section)
Adjust/replace check spring (refer
to the technical manual)
Tighten fabric in the hoop (see
hooping section)
Increase number of backing
pieces
Adjust hook timing (refer to the
technical manual)
Clean, oil, or replace
Replace bobbin
Repair or replace bobbin
Remove scratches with emery
cloth
Adjust needle depth (refer to the
technical manual)
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Skipped stitches
PROBLEM

POSSIBLE CAUSES

SOLUTIONS

Needles

Needle is bent or damaged
Incorrect needle for the thread
size being used
Needle is installed incorrectly

Needle depth

Needle bar lowest dead point is
incorrect
Hook timing is incorrect

Replace needle
Replace with a compatible
needle
Install needle correctly (see
needle replacement section)
Adjust needle depth (refer to
the technical manual)
Adjust gap (refer to the
technical manual)
Replace hook
Replace the bobbin and/or
bobbin case
Adjust the upper tensions

Rotary hook

Upper/bobbin
tension

Presser foot

Thread

Check spring

Hook point is dull
Bobbin thread does not feed
out smoothly
Upper thread does not feed out
smoothly
A weak or broken presser foot
prevents the needle from
coming out of the fabric
smoothly
Thread twist is too tight

Thread is too elastic to form an
adequate loop
The check spring stroke is too
high
The check spring tension is too
high

Replace or strengthen the
spring (refer to the technical
manual)
Use the appropriate thread or
consult the service department
for suggestions

Adjust the check spring stroke
(refer to the technical manual)
Decrease the tension

Needle breaks
POSSIBLE CAUSES

SOLUTION

Needle is bent
Needle installation is incorrect
Needle strikes the rotary hook

Replace needle
Install correctly (see needle replacement section)
Adjust hook timing refer to the technical
manual)
Replace needle
Replace needle
Replace with compatible needle
Adjust position of the needle case (refer to the
technical manual)

Poor needle quality
Dull needle tip
Needle is too small for the fabric
Needle strikes the needle plate
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Loose stitches
POSSIBLE CAUSES

SOLUTIONS

Upper thread tension too low

Adjust the upper thread tensions (see tension
section)
Adjust the bobbin case set screw
Replace with quality thread
Clean tensioner parts
Adjust hook timing (refer to the technical
manual)
Lubricate the rotary hook (see the rotary hook
lubrication section)
Decrease density (refer to the EDS manual for
design editing)

Bobbin tension too low
Uneven thread size
Upper tension inconsistent
Rotary hook timing is incorrect
Inadequate rotary hook lubrication
Design density too tight

Other issues
ISSUE

SOLUTIONS

Bird Nesting

Thread may be wrapped around the hook
assembly; check hook (refer to the technical
manual)
Check the needle plate or run the thread test
design

Burrs
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Wide-angle cap frame
POSSIBLE CAUSES

SOLUTIONS

Poor overall embroidery quality

Make sure the cap is hooped properly
Modify the design
Check that the tensioner is not installed too tightly
Check the driver bar cable tension
Check the spindle adjustment
Check that the driver was properly adjusted on the peripheral
Modify the design
Check that the tensioner is not installed too tightly
Adjust cap supports
Modify the design
Check that the tensioner is not installed too tightly
Check the driver bar cable tension
Check the spindle adjustment
Check that the driver was properly adjusted on the peripheral
Adjust the spindles
Make sure you are using flat needle plates (and NOT raised needle
plates)

Puckering
Loss of registration

Cap frame is loose on the driver
Cap frame driver doesn’t fit on
the peripheral properly
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6. Error Messages
When the peripheral encounters a problem or needs to give you a status update, a message is displayed on the LCD and the machine beeps.
There may be an error in procedure. For example, an error message is displayed if you press the
key before a design is loaded into the Run buffer. You would respond by loading a
design.
It may be a mechanical problem. For example, an error message is displayed if the Y beam reaches
its limit before the design finished sewing. You might need to use a larger hoop.
You may have a sewing problem. For example, an error message is displayed when there is a
thread break. You would rethread the machine and continue.
The following pages of this section contain an alphabetized list of the error messages. If your
machine ever displays an error message that is not listed here, or if you do not know how to
respond to a message that is listed here, contact your Melco service representative for assistance.

Application Run
Means that the peripheral did not download properly. The machine must be turned OFF, then
turned ON again. If this does not work, try reconfiguring your peripheral. If this still does not
work, try reinstalling the software. Call your Melco service representative if this message occurs
often.

Bad Design Name
The machine could not find the design name when
was pressed. If AutoDelete is ON at
the computer, the design is automatically deleted when it finishes sewing. If AutoDelete is OFF,
the design was manually deleted from the Design Menu. Reload the design and continue.

Bad Head Timing Function
Command in the Head Timing Menu was not understood by the Z axis controller. Wait a few seconds and try again. If it still fails, call your Melco Service Representative for assistance.

Bad Instruction
The CPU received an illegal instruction, resulting in a fatal error. Call your Melco service representative for help.
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Bad Keyboard Code
The machine was unable to read input from the keyboard. Turn the machine OFF and back ON,
then do a Power Fail Recovery if necessary. If that does not fix the problem, reconfigure the
machine. When you reconfigure, all parameters will be reset to default values, and your design
must be started from the beginning. If that fails, call your service representative for help.

Bad Power Fail Recovery Pointer
When a design is sewn on the machine, a pointer is saved to mark where the last stitch was
made. This message means a fatal error was detected while the pointer was being saved. If you
get this message, you will not be able to do a Power Fail Recovery. You may try another method
to recover the design, however, such as:
1. Frame through the design to the stopping point; or, if you know the approximate stitch or color
change number, you can use the Goto Stitch or Goto Color function.
2. Press

.

If that doesn't work, turn the power OFF and then back ON; make sure the computer is on and
you are in EDS III or Wilcom software.

Design Delete Failed
The machine was unable to delete the design due to the same design currently running or another design is being downloaded. Wait 20 seconds and try again. This may also be caused by the
design being queued in the Run Menu. If this is the case, perform a Clear Design from the Reset
menu, then delete the design.

Design Job Buffer Full
Means that no more information may be stored in the peripheral's job queue. This will be displayed in the Run Menu.

Design Not Found
This message displays during a Power Fail Recovery if the machine cannot find the last design that
was sewing in the design buffer. Resend the last design from the disk drive and try the Power Fail
Recovery again.

Disk Directory Error
Tried to perform a Directory command on a floppy disk; either the disk is bad, it is the wrong format, or it is not installed. If you encounter this message during a Power Fail Recovery, try again.
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Disk Load Error
An error occurred while trying to load a design from a floppy disk. Try loading the design again. If
the problem remains, you may have a bad disk or drive.

DSP Command Error
The motor controller received an invalid command sequence; this results in a fatal error and the
CPU halts. Call your Melco service representative for help.

Duplicate Design
Tried to load a design from a floppy disk, but the same design is already loaded in the machine.

E-stop Engaged
The Emergency Stop Button is in. Pull or twist slightly to reset.

Found End of Design
An End Of Design dataset was encountered. This message will occur during a Power Fail Recovery.
If this message occurs, you must try another method to recover your design (see Bad Power Fail
Recovery Pointer).

Function Not Allowed
The function you are trying to perform is not allowed currently (e.g., Performing a Hoop Center
command while in the middle of a design is not allowed).

Hoop Limit
If the X or Y motion is not within the sewing field limits when the machine is running, the peripheral will stop and give this error. If performing Frame Forward or Frame Back functions, this error
message will be displayed when you reach the limits of rack movement. If not in the Frame Menu,
then go to the Service/Maintenance Menu and check Hoop Limits in the Configuration Menu.
You may be using a hoop size that is too small for the design, or the design start point is not positioned correctly. Try selecting a larger hoop size in the Options menu, or moving the design start
point so the whole design fits into the hoop, then start over.

Loading Design Try Again
Means that the design has not completed reloading during a Power Fail Recovery. Wait a few seconds and try again.
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Machine Running
You have tried to activate a menu that is not permitted while the machine is sewing. Stop the
machine and try again.

Missed Headup
The Z axis controller missed a Head Up signal. The machine waits for another 150 degrees of rotation; and if the signal still hasn't been seen, stops sewing. This error halts the CPU; you must turn
the power OFF, then ON, then perform a Power Fail Recovery. If this happens frequently call your
Melco service representative for help.

Motor Command Buffer Full
The motor command buffer is full. You may have created more Move commands or Head Timing
commands than the buffer can hold. To clear the MC buffer, turn the power OFF, then back ON. If
cycling the power does not clear the screen message, there may be an error in the CPU.
Reconfigure your peripheral. If this still does not clear the message, call your Melco service representative for assistance.

No Designs Found
Means you are in the Design menu and there are no designs loaded. Either no designs have been
sent from the computer or they have been automatically or manually deleted. The AutoDelete
option may be ON at the computer.

No Design Qued
Means you are trying to do a Power Fail Recovery, a Goto Stitch, or a Goto Color, but there is no
design in the run buffer. Use the Design menu to select a design and try again.

No Free Memory
Tried to load a design from a floppy disk, but there is no room in the Job Buffer. Delete a design
from the buffer and try again.

Not At Headup
Means you are trying to execute an X or Y move function or color change function when the
sewing head is not at Head Up. Cycle to the Head Up position with the Function Menu command
GO TO HEADUP.

Operation Manual for the EMT 1

Melco Embroidery Systems

Error Messages

6-5

Power Fail Recover Job Error
Trying to do a Power Fail Recovery when a design was not started.

Reload <design name>
An error was found when the computer was loading a design while running in Auto Send. Delete
the design and reload it from the computer. Frequent occurrences indicate a system memory problem, or a bad link in the network. Check the terminator to be sure that it is plugged in all the way
or not missing. If this does not fix the problem call your service representative for help.

Means that no design was selected before pressing the
begin sewing.

▲

Run Job Error
key in the Run Menu to

Thread Break
The thread broke, and the machine stopped, then backed up 5 stitches. Make sure the thread
path through the tensioner spring and take-up lever is clear, there is bobbin thread, and the needle is installed correctly. Rethread the needle and press the
key. Check the spring to see
if it is being pulled away.

X Axis Current Limit
This message means that the drive circuit of the X axis motor has detected excess power. This is
caused by a jammed X axis motor or beam or a malfunction of the X axis motor or electronics.
Turn the machine OFF, then back ON to recover. If this error occurs more than once during a
design, call your representative for assistance.

X Axis Move Timeout
See Y Axis Move Timeout.

X Axis Not Done
See Y Axis Not Done.

X Axis Tracking Error
See Y Axis Tracking Error.
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X/Y Home is not Set
Means you tried to do a Move or Trim immediate function without the HOME POSITION being set.
Set Home and continue.

Y Axis Current Limit
This message means that the drive circuit of the Y axis motor has detected excess power. This is
caused by a jammed Y axis motor or beam, or a malfunction of the Y axis motor or electronics.
Turn the machine OFF, then back ON to recover. If this error occurs more than once during a
design, call your representative for assistance.

Y Axis Move Timeout
This error message means the Y rack did not complete its commanded move in the allowed time.
Repeated occurrences of this message may indicate a mechanical bind in the racks or an electrical
problem. To recover from this error exit the Move Function Menu, manually jog the Y rack using
the arrow keys, then try the move again.

Y Axis Not Done
This means the needle is trying to enter the cloth before the X or Y motion is complete. Try to
continue sewing; if error returns, call your Melco service representative.

Y Axis Tracking Error
This error message means the Y axis motor is not tracking (or moving) as commanded by the Y
axis controller software. This error can occur during sewing, trims, tracing, framing and during
moves in the Move Menu. Repeated occurrences of this message may indicate a mechanical bind
in the racks or an electrical problem (check for mechanical binds). The machine will stop sewing
when this problem occurs. To recover from this error when sewing try to Frame Back a few stitches then press the
key to continue sewing. If this doesn't work turn the machine
power OFF then back ON and try a Power Fail Rescue. If this error occurs during tracing, framing
or moving functions try the function again.

Z Axis Current Limit
This message means that the drive circuit of the Z axis motor has detected excess power. This is
caused by a jammed Z axis motor or a malfunction of the motor or electronics. Turn the machine
OFF, then back ON to recover. If this error occurs more than once during a design, call your representative for assistance.
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Z Axis Timeout Error
This error message means that the Z axis was commanded to move, but did not complete the
move in the allowed time. The message can occur during normal sewing or most functions in the
Head Timing menu. To recover, execute the Go To Headup option in the Function menu.
Repeated occurrences of this message may indicate a mechanical bind in the sewing head. It may
be, for example, thread gathered in the hook area, remnants of a broken needle, part of a garment, a tangle of thread, or insufficient lubrication. Locate and correct the problem. If you cannot
locate the problem or if this message continues to occur often, call your Melco service representative .

Z Axis Tracking Error
This means the Z axis motor is not tracking as commanded by the Z axis controller software.
Execute the Go to Headup option in the Function Menu. Exit the Function Menu and press the
key to continue sewing. If the message does not clear, call your Melco representative for
assistance.

Zero Dimension
This message appears when you are creating a custom hoop, but the X or Y dimensions are set to
zero. Change the X and Y dimensions to a number greater than zero to clear the message.
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7. Glossary of Embroidery Terms
A
ACTIVE WINDOW
The window that you are currently using. Also called the current window.
ALPHABETS
Lettering styles that are ready to use for embroidery. Alphabets can also be designs that are
brought to the screen using letters of the alphabet. An example of this would be Sports Symbols.
APPLICATION WINDOW
The first window to appear when EDS III is opened; screen says Melco in large letters across the
middle of the screen. The Application Window has three menu bar items; File, Peripheral, and
Help.
APPLIQUE
The art of using fabric shapes with satin stich outlines to enhance a design or to reduce the stitch
count.
ARTWORK
A design or cartoon used to digitize.
AUTO DELETE
An option that automatically deletes designs from the sewing peripheral after the design has
sewn once. Machine will display Bad Design Name when the design finishes.
AUTO RUN
An option that automatically sends a design to the beginning of the job queue, allowing you to
sew without making any selections from the peripheral menus.
AUTO TRIM
An option that automatically inserts a trim command between each letter of any alphabet (including scripts) used in a design.
ARC ANGLE
The center of lettering sewn on a circle. This position is given in degrees, 0° at the top of the circle, 180° at the bottom.
ARC FROM CENTER
When the position of the needle prior to sewing is at the center of the circle. The distance from
the center of the circle to the bottom of the lettering is the radius. When traced, the trace
includes the entire area.
ARC NORMAL
When the position of the needle prior to sewing is on the circumference of the circle. When
traced, only the areas of the lettering is traced.
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ASD
The file extension given by EDS III to a design that is sent to the peripheral.

B
BACKING
Fabric used for stabilizing that is added to the back of a garment to be embroidered.
BEAN STITCH
A form of running stitch where the stitch is made forward, then back to the original needle penetration point, then forward again. Also known as a triple run.
BIRD NEST
A tangled mass of thread that gets jammed in the needle plate. Sometimes it is caused by improper tensions or densities.
BIT PAD
Another name for a Digitizing Tablet.
BLOCK
A designated group of stitches that can be scaled, rotated, repositioned, deleted, cut, copied and
pasted.
BLOCK EDIT
The term used for changing a defined group of stitches.
BOBBIN
The reel or spool that holds the under thread of machine sewing. The under thread itself.

C
CENTER DESIGN
Positing the design in the center of the sewing field.
CHAIN STITCH
A stitch used to outline and detail a chenille design.
CHENILLE
A form of embroidery with a deep pile that uses heavy yarns and has no bobbin thread.
Commonly used for high school letter jackets.
CLICK
Pressing and releasing a mouse button in one quick motion.
CLIPBOARD
A temporary storage area in the computer's memory. Data in the storage area can be copied to
another place.

Operation Manual for the EMT 1

Melco Embroidery Systems

Glossary of Terms

7-3

CND
The three letter extension given to a Condensed file. See Condensed Format for more information.
COLUMN FILL
An option to turn wide column or satin stitches into a series of shorter stitches. Commonly used
to make alphabet letters 2.5" or larger more durable.
COLUMN STITCH
A stitch formed with one needle penetration on either side of a column. Also referred to as a satin
stitch or a steil stitch.
COLUMN WIDTH
The width of the actual side-to-side needle penetrations in a column or satin stitch. In EDS III, the
width can be increased or decreased in increments of 10% from 90% to -90%.
COMPLEX FILL
A method for digitizing fills where the computer automatically determines the various independent segments that are required in making the complete fill of an irregular shape.
CONDENSED FORMAT
A coding format that includes only the data for the Mk entries and function commands created
during digitizing. This format allows you to scale the design up or down as well as change the
density and stitch length of the design.
COPY
A command that keeps the design in the current window and also stores it in a temporary memory called the clipboard.
CURSOR
An icon used to indicate your position on the computer screen.
CUT
An editing function used to take selected stitching out of a design and store it in the clipboard.
From there it may be pasted to a different place.

D
DATASET
Any single line in the stitch list. An example would be any Mk point.
DEFAULTS
Values that are automatically used unless you override them with different values.
DENSITY
The space between needle penetrations, measured in points—not the number of stitches per inch.
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DESIGN FILE
Any design stored on your hard disk or floppy disk. A file name can have up to eight letters, a
period, and a three letter extension.
DIALOG BOX
A box displayed on your computer screen that prompts you to give information, such as a selection from a list of options, or a file name.
DIGITIZING
Converting artwork into a series of commands that can be read by an embroidery machine with
the use of a special device.
DIGITIZING TABLET
A board used to communicate with a computer or an embroidery machine while creating a
design.
DIGITRAC
The original Melco computerized digitizing system which uses an exceptionally large surface and
its own vertical stand.
DIRECTORY
A named group of computer files stored on one of your computer drives. The hard drive of your
computer is usually the C directory. Floppy diskettes are inserted into the A or B drive. The CDROM drive is usually the D drive.
DISK
A computer data storage device which is accessed in the hard drive or one of the floppy drives.
The hard drive of your computer is usually the C drive. Floppy diskettes are the A or B drive. The
CD-ROM drive is usually the D drive.
DISKETTE FORMAT
The manner in which a disk has been prepared to accept information.
DITHERED COLORS
A combination of a solid color and a pattern.
DOUBLE CLICK
Pressing the mouse button quickly two times.
DRAG
Holding down the mouse button while moving the mouse. This is usually done to move an object
on the screen or to highlight text.
DROP-DOWN MENU
A list of available commands that displays when you click on a menu option. Commands displayed
in black are accessible, commands that are displayed in gray or half tone are not.
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E
EDIT
Changing a design file by adding, deleting or moving Mk points, or by inserting and deleting
functions.
EMBROIDERY POINT
A unit of measure equal to one tenth of a millimeter or 1/254th of an inch.
EXP
The three letter extension given to an Expanded file.
EXPANDED FORMAT
A coding format that includes the data for every stitch in the design.
EXPORT
Copying a design from the computer to a non-DOS format diskette or paper tape.
EXTENSIONS
The last part of a file name after the period. It can be up to three characters long and is used to
identify the type of file.

F
FILE
A collection of information, named and stored on a disk. Every piece of information on your computer’s hard drive is stored in a file.
FILE NAME
The unique identifier given to a design that is stored on a computer. The file name can have up to
eight characters, a period, and an up to three letters extension.
FILL STITCH
A series of running stitches used to cover large areas.
FORMAT
Preparing a disk to receive information. All new disks must be formatted, but reformatting a disk
destroys any information stored on it. Your computer uses a DOS format, but you can format floppy disks to machine language formats.
FUNCTION
An action caused by a command in a design such as Trim, Color Change, Needle Up, etc.
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G
GRAPHICAL ROTATION
Angling a design in the Layout window using the mouse to click and drag the rotation box
around the object.
GRAPHICAL SCALING
Making a design larger or smaller in the Layout window using the mouse in a click and drag
motion.
GROUP OBJECTS
Objects that have been locked together on the screen.

H
HARD DISK
A sealed disk in your computer with a read/write head and auxiliary memory. Usually the C drive.
HOOP
A device made of wood, metal, or plastic used to hold a garment or fabric taut during the
embroidery process.
HORIZONTAL SPACING
Additional spacing that may be added between Alphabet letters.

I
ICON
A small graphic representation of something larger.
IMPORT
Bringing a design file into the EDS III program from a non-DOS formatted diskette or paper tape.
INSERT
Adding additional information to an existing design.

J
JUMP STITCH
A frame movement without a needle penetration. It function allows you to make a stitch longer
than the maximum stitch length of your machine.

L
LAYER BY COLOR
Used to show specific colors of a design on the computer screen. Only works in the Object Edit
Window.
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LAYOUT WINDOW
The screen in which you can digitize designs, open files on the hard disk, import designs from
floppy disks, export designs, modify designs, and create lettering.
LETTER WIDTH
Modifies the overall width of each letter, NOT the column width. In EDS III changes to letter width
can be made in increments of 10% from +30% to -30%.
LINE CENTER BOTTOM
When lettering is centered horizontally and above the position of the needle prior to sewing. It
will sew above Y=0° except for lower case letters such as g, y, p, or q; used to sew over a straight
line on fabric such as a pocket.
LINE CENTER MIDDLE
When lettering is centered horizontally and vertically from the position of the needle prior to
sewing.
LINE NORMAL
When the bottom left of the lettering is the needle position prior to sewing. The sewing will stop at
the bottom right and will not return to the original position. It will sew above Y=0° and to the right
of X=0° used to position design; used to align to the right of a vertical line such as a plaquet.
LINE SPACING
Adding space between lines of lettering in the same text box. Line space is determined by adding
the letter height to the amount of blank space you want between the lines.
LIST BOX
A box, usually with a scroll bar, that appears within a dialog box and displays available options.
LOAD FILL
Accessing a fill pattern for inspection or changes.
LOCK GROUP
One or more objects that have been joined together.
LOCK STITCH
Three or more stitches placed closely together to prevent the embroidered stitches from pulling
out. Also know as a tie-off stitch.

M
MAXIMIZE
The small button to the right of the Title Bar with the up arrow. Used to enlarge a window to its
fullest extent.
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MAXIMUM STITCH LENGTH
The longest stitch your embroidery machine is capable of sewing before performing a jump stitch.
The maximum stitch length for Melco is 127 pts.
MINIMIZE
The small button on the right of the Title Bar with the down arrow. Used to reduce a window to
an icon.
MODIFY Mk BUTTON
An option that changes the position of a Mk point or changes the Mk to a different type of Mk.
Double-clicking on a specific point in the stitch list opens the Modify Mk dialog box.
MOSS STITCH
The "loopy" part of a chenille design. The height of the loop is controlled by the height of the
needle.
MULTIHEAD
An embroidery machine with more than one sewing head.

N
NEEDLE UP
A command used to move from one part of a design to another without stitching.
NON-DOS FORMATS
Any disk format other than DOS that is supported by EDS III, such as: Melco, Tajima, Barudan,
ZSK.
NORMAL STITCH
A command that resets the stitching to a regular running stitch. It also brings the needle down to
the sewing position after a needle-up function is performed.

O
OBJECT
Any design from a disk, paper tape, or lettering brought in to the Layout window. Several objects
can be in one window at one time.
OBJECT FILE
A code format where each object has its own separate set of parameters. Condensed, expanded
and lettering designs can all be saved together as an Object File.
OBJECT ORDER
A list showing the sewing order of a group of objects.
OBJECT PARAMETERS
A dialog box which allows you to change the scale, rotation, orientation, or lock status of an
object.
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OFM
The three letter extension that identifies an Object file.
ORIENTATION
The direction that a design will sew. Melco uses an "F" to designate a normal sewing position.
ORIGIN
The point at which a design will start. Most designs will have x and y coordinates of 0,0; meaning
that the design will start in the center and end in the center.

P
PAPER TAPE
An older form of computer information storage in which the information is stored as a series of
holes on a reel-to-reel paper tape.
PARTITION LINE SEQUENCE
Determines where the needle will penetrate on each line of stitching in a fill stitch. Changing this
sequence changes the texture of a fill.
PERIPHERAL
Any device that is attached to or run by the computer: Embroidery Machines, Paper Tape Punches,
Digitizing Tablets, Printers, or Plotters.
PERIPHERAL SETUP
A dialog box that allows you to select Embroidery Peripherals in your network.
PERIPHERAL STATUS
A dialog box that displays information about a particular peripheral.
POINT EDIT WINDOW
One of the windows that is used to edit designs.

R
RADIUS
The distance from the center to the circumference of a circle. The value of the radius controls the
amount of curve in an arc.
REGENERATE
A command to redraw a design, used to see modifications in the current design.
RESET STITCH
See Normal Stitch.
RETURN TO ORIGIN
A command used to move the pantograph back to the origin of the design.
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RUBBER BANDING
A command to view an edited portion of a design without regenerating the entire design.
RUNNING STITCH
A line of equally spaced stitches that are used to outline, underlay or add detail to a design.

S
SATIN STITCH
A stitch formed with one needle penetration on either side of a column. Also called a column
stitch or steil stitch.
SAVE
A command to overwrite a previously saved file without prompting you for a new filename.
SAVE AS
A command to store a design for the first time, or to store a modified design with a new name to
prevent destruction of the original design.
SAVE FILL
A command to allow you to define fill information while digitizing.
SCALING
The process of changing the size, density or stitch lengths in a design.
SCROLL BAR
A bar that appears at the far right or bottom edge of a window or list box whose contents are
not fully visible. Clicking on the arrows of the bar moves the viewing portion of the screen.
SEND DESIGN
Sends all items on the screen together under one design name. The design can be a condensed,
expanded, or object file.
SHORT STITCHES
Computer generated stitches that do not go all the way across a column at a curve or angle to
prevent an excess of stitches at one point cutting the fabric. Short Stitches defaults to ON, but
may cause gaps in smaller letters and should be turned off in letters 0.5" or smaller.
SLANT ANGLE
A command that slants lettering in one degree increments up to fifteen degrees, positive or negative.
SPECIAL STITCH
A user defined stitch that is digitized and stored temporarily in the computer memory. A Special
Stitch is limited to 30 Mks or commands.
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STATUS BAR
The area at the bottom of the computer screen that displays information about the active window
or selected command.
STITCH
One needle penetration made by the embroidery machine.
STITCH COUNT
The number of stitches in a design.
STITCH LENGTH
The length of the running stitches in a design. Measured in points.
STITCH LIST (condensed)
Information showing the Mk points and functions that make up a design.
STITCH LIST (expanded)
Information showing the actual stitches and functions that make up a design.
STITCH PROCESSOR
An EDS III option that changes the size, densities, or stitch lengths of an expanded design.
STORED SYMBOL
A portion of a design that is digitized as a separate piece to be used multiple times within the
same design. An example of this would be a leaves on a tree. You would digitize one leaf as a
stored symbol then use that same leaf and place it on the tree at various different sizes and
angles. This eliminates redigitizing the same design.

T
TIE OFF
See Lock Stitch.
TILE
Allows you to put up to nine windows in the Application Window.
TOOL SET
The commands and options on the left side of the window represented by icons.
TRANSFER DESIGN
A command that sends Expanded or ASD files to the Peripheral.
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U
UNDERLAY
Stitches used to stabilize fabric and/or prepare the area for top stitching.
UTC
UTC is the Under Thread Control. It is a sensor mounted to the needle plate bracket that recognizes the absence of the bobbin thread. When the machine sews a certain number of stitches
without bobbin thread, the UTC causes the machine to stop, back up that number of stitches,
and display the error message, CHECK BOBBIN. The UTC also has a retaining tab that holds the
inner basket of the rotary hook. The UTC am must be set close enough to allow the thread to
move it as stitches are made. Incorrect alignment of the UTC generates repeated Check Bobbin
error messages.

V
VERTICAL SPACING
A command that stair steps your lettering up (positive value), or down (negative value).

W
WINDOW
A rectangular area on your screen in which you view and work on designs.

Z
ZOOM
A command that enlarges or reduces a portion of a design in the current Layout window, allowing
you to edit with more precision. This command does not affect the sewing size of the design. To
view the design as the size it will be sewn, click View→Actual Size.
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▲

▲

Load a Design (through the Disk Drive)
1. Press
to display the Directory
Menu.
2. Place the diskette with the design to be
loaded in the disk drive, then press
.
3. Press
or
until
▲
▼
the desired design name is showing on the display, then press
. When the design is
loaded, the display will read: DESIGN MENU.

▲

▲

▲

again.

11. When ready to sew, press
, then press
.
12. Press
to begin embroidering.

▲

▲

▲

▲

▲

▲

Hot Keys
Press
to toggle between the
Main menu and the Service/Maintenance menu.

▲

Repeat by pressing

Delete a Design
1. Press
until the display reads: DESIGN
MENU.
2. Press
.
3. Press
or ▼ to scroll to the right
▲
design file.
▼
4. Press
. The display reads:
DELETE FILENAME?.
▲
5. Press
for YES or ▼ for NO.
6. Press
.

Press
to toggle in and out of
the Language selection menu.
▼

▲

▲
▼

Press

▲

to increase sewing speed.

Press

▼

to decrease sewing speed.

▲

Press
jog the rack.

▼

▲

▲

Reset Designs
1. Press
until the display reads: RESET
MENU.
2. Press
. The display reads: CLEAR
DESIGN.
3. Press
. The display reads **RESET**.

Raise the Needle
1. Press
until the display reads: FUNCTION MENU.
2. Press
.
▲
3. Press
; the display shows GO TO
HEADUP.
4. Press
; the needle comes up.
5. Press
to exit the function menu.

▲

▼

▲

▲

Select an Orientation
1. Press
until the display reads
OPTIONS MENU. Press
.
▲
▼
2. Press
or
until the display
reads ORIENTATION.
3. Press
or
to scroll
to the desired orientation. Press
.

Run a Design
1. Press
until the display reads: DESIGN
MENU.
2. Press
.
3. Press ▲
or ▼ to scroll to the design
you want, then press
.
4. Press
. The display reads: RUN
DESIGN.
5. Press
. First the display reads:
<machine name> READY, then shows the
design name.
6. Press
until the display reads: FUNCTION MENU.
7. Press
.
▲ or
▼ until the display reads:
8. Press
TRACE DESIGN OUTLINE.
9. Press
. First the display reads: CALCULATING, then shows the design name.
10. Press
. The trace function begins.

▲

▲

▼

▲

▲

Select a Hoop Size
1. Press
until the display reads: OPTIONS
MENU.
2. Press
.
3. Press
or
to scroll to right the
hoop size.
4. Press
until the display reads: FUNCTION MENU. Press
.
▲
5. Press
or
until the display
▼
reads: GO TO HOOP CENTER.
6. Press
.

▼

and any arrow key to manually
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EMT MENU AND COMMAND QUICK REFERENCE
MAIN OPERATOR MENU

IDLE MODE
Two displays are available whenever
the machine is in Idle Mode:
Current stitch, max speed,
and needle number
Name, current speed, orientation,
needle number, and percent
complete

Directory Menu

Head Timing Menu

Design Menu

4 Hour Lubrication Menu

Run Design Menu

8 Hour Lubrication Menu

Function Menu

40 Hour Lubrication Menu

Go To Hoop Center

480 Hour Lubrication Menu

Set Home

2100 Hour Lubrication Menu

Power Fail Rescue

Configuration Menu

Return To Origin

Accumulate Needle Ups

Return To Last Stitching Position

Return to Design Origin at EOD

Go To Stitch

Start Rack Motion Offset

Go To Color Change

Unit of Measure

Go To HeadUp

Hoop Limits

Design Filter Stitch Length

Orientation Option

Language Selection

Turbo Mode

Max Jump Stitch Speed

Floppy Disk Format
Frame Menu

Move Function Menu
Move X/Y
Define Custom Hoop Menu

Frame Back

Test Mode Menu

Frame Forward

Diagnostics Menu

Reset Menu

= Top-level menu

Clear Design

= Sub-menu

Hard Reset

= Command or function

Design Filter

Select Hoop

Center Design

= View available when machine is
in idle state

80 Hour Lubrication Menu

Trace Design Outline

Options Menu

Key

SERVICE/MAINTENANCE MENU

